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Important Information

Warning Regarding Medical and Clinical Use 
of National Instruments Products

National Instruments products are not designed with 
components and testing for a level of reliability 
suitable for use in treatment and diagnosis of humans 
or as critical components in any life support systems 
whose failure to perform can reasonably be expected 
to cause significant injury to a human. Applications 
of National Instruments products involving medical 
or clinical treatment can create a potential for death 
or bodily injury caused by product failure, or by 
errors on the part of the user or application designer. 
Any use or application of National Instruments 
products for or involving medical or clinical 
treatment must be performed by properly trained 
and qualified medical personnel, and all traditional 
medical safeguards, equipment, and procedures that 
are appropriate in the particular situation to prevent 
serious injury or death should always continue to be 
used when National Instruments products are being 
used. National Instruments products are NOT 
intended to be a substitute for any form of established 
process, procedure, or equipment used to monitor or 
safeguard human health and safety in medical or 
clinical treatment.
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The media on which you receive National Instruments software are warranted not to fail to execute programming 
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PRODUCTS (THE "PRODUCTS") ARE PROVIDED ON AN "AS IS WITH ALL FAULTS" BASIS WITHOUT 
WARRANTY OF ANY KIND, AND NO OTHER WARRANTIES, EITHER EXPRESSED OR IMPLIED ARE 
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WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, ANY OTHER 
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DISCLAIMS ANY WARRANTIES NOT STATED HEREIN.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside 
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costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully 
reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments 
reserves the right to make changes to subsequent editions of this document without prior notice to holders of this 
edition. The reader should consult National Instruments if errors are suspected. In no event shall National Instruments 
be liable for any damages arising out of or related to this document or the information contained in it.

THE ENTIRE LIABILITY OF NI AND ITS LICENSORS, DISTRIBUTORS, AND SUPPLIERS (INCLUDING ITS 
AND THEIR DIRECTORS, OFFICERS, EMPLOYEES, AND AGENTS) IS SET FORTH ABOVE. TO THE 
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DISTRIBUTORS, AND SUPPLIERS (INCLUDING ITS AND THEIR DIRECTORS, OFFICERS, EMPLOYEES, 
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DIRECT, INDIRECT, INCIDENTAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES, EXPENSES, LOST 
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About

This

Manual

Use the BioBench User Manual to learn the features, functions, and 

operation of BioBench. BioBench can help you acquire and analyze 

biological data. The BioBench User Manual is intended for use by life 

science students and research professionals who acquire lab data using a 

personal computer. To use this manual effectively, you should be familiar 

with the Windows 95 operating system.

Organization of This Manual

This manual is organized as follows:

• Chapter 1, Introduction to BioBench, introduces the BioBench 

application.

• Chapter 2, Setting Up Your System, explains how to set up your 

BioBench system and start the BioBench application.

• Chapter 3, Acquiring Data, gives instructions for acquiring data with 

BioBench after you have set up your system.

• Chapter 4, Analyzing Data, explains the ways you can analyze data in 

BioBench.

• Chapter 5, Saving Data, explains how to record and save your 

BioBench data.

• Chapter 6, Printing Data, explains how BioBench can print snapshots 

of your signals as they appear on the screen, or print reports that 

summarize the data you acquire.

• Appendix A, Using Help and Troubleshooting, explains how to use the 

BioBench online help features and also offers some troubleshooting 

tips.

• Appendix B, Examples, gives you step-by-step examples on how you 

can use BioBench. Some of these examples use data files that come 

with your BioBench application in the \biobench\examples 

directory.

• Appendix C, Customer Communication, contains forms you can use to 

request help from National Instruments or to comment on our products 

and manuals.
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About This Manual

• The Glossary contains an alphabetical list and description of terms 

used in this manual, including abbreviations and acronyms.

• The Index contains an alphabetical list of key terms and topics in 

this manual, including the page where you can find each one.

Conventions Used in This Manual

The following conventions are used in this manual:

<> Angle brackets enclose the name of a key on the keyboard (for example, 

<Shift>).

- A hyphen between two or more key names enclosed in angle brackets 

denotes that you should simultaneously press the named keys, for example, 

<Ctrl-Alt-Delete>.

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options»Substitute 

Fonts directs you to pull down the File menu, select the Page Setup item, 

select Options, and finally select the Substitute Fonts option from the last 

dialog box.

bold Bold text denotes the names of menus, menu items, and buttons.

bold italic Bold italic text denotes a note, caution, or warning.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept.

monospace Text in this font denotes text or characters that you should literally enter 

from the keyboard, sections of code, programming examples, and syntax 

examples. This font also is used for the proper names of disk drives, paths, 

directories, programs, subprograms, subroutines, device names, filenames, 

and extensions, and for statements and comments taken from programs.

monospace bold Bold text in this font denotes the messages and responses that the computer 

automatically prints to the screen. This font also emphasizes lines of code 

that are different from the other examples.

monospace italic Italic text in this font denotes that you must enter the appropriate words or 

values in the place of these items.
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paths Paths in this manual are denoted using backslashes (\) to separate drive 

names, directories, and files, as in C:\dir1name\dir2name\filename.

This icon to the left of bold italicized text denotes a note, which alerts you 

to important information.

Customer Communication

National Instruments wants to receive your comments on our products 

and manuals. We are interested in the applications you develop with our 

products, and we want to help if you have problems with them. To make 

it easy for you to contact us, this manual contains comment and 

configuration forms for you to complete. These forms are in 

Appendix C, Customer Communication, at the end of this manual.
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Chapter

1Introduction to BioBench

This chapter introduces the BioBench application.

What Is BioBench?

BioBench is a stand-alone application designed to meet the data 

acquisition and data analysis needs of the life science, medical research, 

and education markets. It has ready-to-run data acquisition and data 

analysis capabilities that can help you save time and 

money by integrating your personal computer with your physiological 

monitoring system.

Using National Instruments data acquisition hardware, you can use 

BioBench to acquire data from virtually any type of physiological, 

linear-voltage signal source. While your physiological data is being 

acquired, BioBench can save it to disk along with any notations you 

want to add. After you save your data to disk, you can use BioBench 

to open your data file for review and analysis.

Why Use BioBench?

BioBench can help you with your physiological data acquisition and 

data analysis needs in the following ways:

• Data Management—BioBench automatically keeps track of the 

user name and the date and time each data set was acquired. 

BioBench has an intuitive data management scheme that allows 

you to organize your data into testgroups. You can associate a 

data set with any testgroup.

• Vendor Data Storage—BioBench makes data acquisition 

configuration and setup easy with the use of a built-in vendor 

database. The vendor database includes BioBench configuration 

information for many of the most widely used physiological 

monitors and amplifiers. 
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• Automatic Journal Creation—BioBench automatically generates 

entries in a journal to indicate that a user changed voltage output 

stimulus levels or turned data logging on or off during an 

acquisition. You can also add your own entries to the journal. 

• File Analysis—You can use the BioBench analysis views to open, 

review, and analyze your data. 

• File Exporting—You can write your data to an ASCII spreadsheet 

file for further analysis in other software applications.

• Look and Feel of a Chart Recorder—BioBench’s graphs have the 

look and feel of traditional physiographs and strip chart recorders 

that you are accustomed to using.

• Configuration Settings—BioBench can load, save, and reset your 

settings. This saves time when multiple users have different 

configuration settings.

• Example Data Files for Teaching—BioBench includes many 

example data files that you can replay in the classroom without the 

use of any data acquisition hardware or physiological monitoring 

equipment. You can also replay your own recorded data sets to 

show students what your unique signals look like in real time.

Go to Chapter 2, Setting Up Your System, to learn about getting started 

with BioBench.
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Chapter

2Setting Up Your System

This chapter explains how to set up your BioBench system and start the 

BioBench application.

Minimum System Requirements

Your computer must have the following hardware and software to work 

with BioBench:

• Microsoft Windows 95 or Windows NT 4.0

• Personal computer using at least a 33 MHz 486 or higher 

microprocessor with floating-point capability (National 

Instruments recommends a 66 MHz 486 or higher microprocessor 

with floating-point capability)

• CD-ROM drive

• VGA resolution (or higher) video adapter

• Minimum of 16 MB of RAM

• 25 MB free hard disk space

• Microsoft-compatible mouse

Installing Your NI-DAQ Software

To install your NI-DAQ software, refer to the NI-DAQ User Manual for 

PC Compatibles. When you install NI-DAQ, use the Driver Files 

Installation option, which is the default setting.
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Installing Your Hardware

To install and configure your hardware, refer to the user manual for 

your National Instruments data acquisition (DAQ) hardware.

Installing BioBench

National Instrument ships BioBench in CD format only. This section 

describes installation from CD. This section also describes how to 

create installation diskettes from the BioBench CD. You can use the 

diskettes to install BioBench on a computer that does not have a 

CD-ROM drive.

Using the BioBench CD to Install BioBench

To install BioBench, complete the following steps:

1. Insert your BioBench CD into your CD-ROM drive.

Note: At this point your operating system might prompt you to run setup.exe. 

You should ignore this prompt, select Close, and continue to the next step.

2. Select Run from the Windows NT/95 Start menu.

3. Type x:\disk1\setup in the input box, where x is the letter of 

your CD drive.

4. Click on the OK button. 

5. Follow the instructions that appear in the dialog boxes.

6. If the BioBench installer does not find Adobe Acrobat Reader 3.0 

installed on your computer, the installer prompts you to install it. 

You need the Adobe Acrobat Reader to view the online version of 

the BioBench documentation. If you choose not to install Adobe 

Acrobat Reader during the BioBench installation, you can install it 

later by running \acrobat\ar32e30.exe, an executable that the 

BioBench CD places in your biobench folder during installation.
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Creating and Using Installation Diskettes for BioBench

Although BioBench comes on CD only, you can make installation 

diskettes by performing the following steps:

1. Insert a formatted 1.44 MB diskette into your floppy disk drive.

2. Insert your BioBench CD into your CD-ROM drive.

3. Copy the entire contents of x:\disk1 (where x is the name of your 

CD drive) to your floppy diskette.

4. Repeat for all x:\diskn folders on the CD.

To install BioBench from the diskettes you create, perform the 

following steps:

1. Insert Disk 1 into your 3.5-inch floppy disk drive.

2. Select Run from the Windows NT/95 Start menu.

3. Enter a:setup or b:setup (depending on whether the pathname of 

your floppy disk drive is A or B) in the input box.

4. Click on the OK button.

5. Follow the instructions that appear in the dialog boxes.

6. If the BioBench installer does not find Adobe Acrobat Reader 3.0 

installed on your computer, the installer prompts you to install it. 

You need the Adobe Acrobat Reader to view the online version of 

the BioBench documentation. If you choose not to install the Adobe 

Acrobat Reader during the BioBench installation, you can install it 

later by running \acrobat\ar32e30.exe, an executable that the 

BioBench CD places in your biobench folder during installation.
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Starting BioBench

To start BioBench, select Start»Programs»BioBench 1.0»BioBench.

After you start BioBench, the User Login dialog box appears, shown in 

Figure 2-1. Type in your name or select it from the list. It is important 

to select the correct user name, because BioBench associates the name 

you select with any data you acquire and save to disk.

You can also change the user name after you start BioBench by 

selecting File»Username and entering a different name.

Figure 2-1.  User Login Dialog Box
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Data Acquisition View
When you first install and open BioBench, the data acquisition view 

appears. Figure 2-2 shows what your screen might look like while you 

acquire data. Chapter 3, Acquiring Data, explains the data acquisition 

views in detail.

Figure 2-2.  4 Graph Acquisition View
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Setting Up BioBench for Acquisition

If you want to change the names of the signals or any of the default 

settings, you should follow the instructions in this chapter.

When you first install BioBench, and you have properly installed your 

DAQ hardware, BioBench automatically configures itself to begin 

acquiring data with default settings. All you need to do is click on the 

GO button. The default settings are configured for signals that fall in 

the –5 to +5 VDC range. You must perform additional configuration 

steps if you want to use alarms, logging, or stimulus.

Selecting a Data Source

The data source for your BioBench application can be DAQ hardware 

or a data file. The data file can be a file included with BioBench in the 

\biobench\examples directory or a data file you previously acquired 

with BioBench. 

You may want to use the files in the \biobench\examples directory 

when you cannot do direct physiological data acquisition. You can 

always add new files to the \biobench\examples directory if the 

provided files do not meet your needs. Because BioBench can use data 

files as a data source, you can use a data file to simulate real-time data 

acquisition on a computer that does not have DAQ hardware.

You might want to change the data source if one of the following 

conditions is true:

• This is the first time you have used BioBench, and you need to 

select the DAQ hardware that you want to use to acquire data.

• You do not have DAQ hardware in your computer, and you want to 

use a data file to simulate data acquisition.

• You want to use a different data source than you did the last time 

you acquired data.
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To choose a data source, select Configure»Data Source. Figure 2-3 

shows the Select Data Source dialog box.

Figure 2-3.  Select Data Source Dialog Box

The following controls appear in the Select Data Source dialog box:

• National Instruments Data Acquisition Hardware—This option 

allows you to select any National Instruments DAQ hardware that 

is installed and configured in your computer. You can select only 

one piece of DAQ hardware at a time. BioBench can only collect 

data from signals connected to the selected DAQ hardware. If the 

DAQ hardware you expect to see is not listed, make sure that it is 

properly installed and configured using the NI-DAQ Configuration 

Utility.

• Demonstration/Teaching Data Files—This option allows you to 

select a data file that contains sample or teaching data. You can 

replay the selected data file in simulated real time, even if the 

computer you are using does not have DAQ hardware. BioBench 

displays the data files found in the \biobench\examples 

directory when you choose this option. You can always add new 

example files to the \biobench\examples directory to meet your 

specific needs. The files you add must be created with BioBench.

• Data Files Acquired with BioBench—This option allows you to 

select any BioBench data file that has been stored to disk 

previously. You can replay the selected data file in simulated real 

time, even if the computer you are using does not have DAQ 

hardware. Use the Browse button to select the directory that 

contains the data file.
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Configuring Your DAQ Hardware Channels
If you want to use DAQ hardware to acquire signals with BioBench, you 

must configure the hardware first. To configure the hardware, you must 

tell BioBench what types of signals you will be acquiring on each 

channel.

Note: Make sure your DAQ hardware and NI-DAQ software are correctly 

installed before trying to configure the channels.

To configure hardware, select Configure»Channels in the data 

acquisition view. Figure 2-4 shows the Channel Configuration dialog 

box.

Figure 2-4.  Channel Configuration Dialog Box

The following controls appear in the Channel Configuration dialog box:

• Data Acquisition Hardware—This list shows all the National 

Instruments DAQ hardware that is installed in your computer. 

Choose the DAQ hardware you would like to use to acquire data. If 

the DAQ hardware you expect to see is not listed, make sure that it 
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is properly installed and configured using the NI-DAQ 

Configuration Utility.

Note: The DAQ hardware you select in this dialog box automatically becomes the 

data source.

• Channels—This list shows all of the channels available on the 

selected DAQ hardware (up to 16 channels). 

To configure a channel, select the channel and then enter a Signal 

Label, Signal Voltage Range, and Scaling parameters. BioBench 

automatically configures all channels when you first install your 

DAQ hardware. 

When you enter characters for any channel in the Signal Label 

field, the not connected label disappears and the channel is 

configured for acquisition. If you click on Disconnect Signal, the 

channel reads not connected and the Signal Label is blank. If a 

channel reads not connected, the channel is not configured for 

acquisition. 

If a channel reads not available and is grayed out, you cannot 

select the channel. This display state occurs when your DAQ 

hardware does not support the channel number. Also, the 

configuration you selected in the NI-DAQ Configuration Utility 

can affect which channels are available. 

• Signal Label—Enter the label of the selected channel in this field. 

This label appears on the graph that displays the signal.

• Signal Voltage Range—Specify the minimum and maximum DC 

voltage of the signal that is connected to this channel.

• Scaling—This group of controls allows you to set various scaling 

parameters.

– Units—Choose the engineering units (egu) for the selected 

channel. Select New... to define a new engineering unit.

– Min & Max—When you select Min & Max, BioBench 

calculates Gain (m) and Offset (b) based on the Signal Voltage 

Range and Scaling Min, Max (egu) values.

– Gain & Offset—When you select Gain & Offset, BioBench 

calculates Scaling Min, Max (egu) based on the Signal Voltage 

Range and Gain (m) and Offset (b) values that you supply.

– Min (egu), Max (egu)—Enter the minimum and maximum 

engineering values corresponding to the minimum and 

maximum volts DC values you enter in Signal Voltage Range.
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– Gain (m), Offset (b)—BioBench uses the gain and offset to 

convert voltages to engineering units using the equation 

Y = mX + b, where X is the signal in VDC and Y is the signal 

converted to the unit you select.

– Calibrate—This button opens the 2-Point Calibration dialog 

box, shown in Figure 2-5. You can use the two-point 

calibration routine to determine the Signal Voltage Range that 

applies to the Scaling Min, Max (egu) values. For more 

information, refer to the next section, Two-Point Calibration 

Routine.

• Disconnect Signal—Click on this button to remove the selected 

channel from the current configuration. A not connected label 

appears for the selected channel in the Channels list.

• Vendor Database—Click on this button to open the Vendor & 

Device Database Maintenance dialog box, described later in this 

chapter. You can retrieve information about a device connected to 

the selected channel from the vendor database to help you 

configure the channel.

• Vendor/Device—When you use the vendor database to configure 

the selected channel, the vendor and device appear in this indicator.

• Help—This button opens or closes the Help window. It has the 

same effect as the Popup Help option in the Help menu. 

Alternatively, you can press <Ctrl-h> to open or close this window.
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Two-Point Calibration Routine
You can use the two-point calibration routine to directly measure the 

signal voltage range in the Channel Configuration dialog box, instead 

of typing in those values.

Figure 2-5.  Two-Point Calibration Dialog Box

The following controls appear in the 2-Point Calibration dialog box:

• Signal Label—The label of the signal you are calibrating. It is the 

label you entered in the Channel Configuration dialog box.

• Minimum/Maximum Areas—You specify several parameters for 

both the low (minimum) and the high (maximum) calibration 

values:

– Voltage—This meter and its digital indicator show the voltage 

level that BioBench is currently measuring. The longer (red) 

needle on the meter indicates the instantaneous values while 

the shorter (blue) needle indicates the accepted value. 

– Accept—When you have properly set the output calibration 

voltage of the physiological monitoring device or amplifier, 

click on the Accept button to record the voltage as the 

calibration voltage. Perform this operation for both the 

Minimum and Maximum calibration points. BioBench uses a 

ten-point average to calculate the calibration voltage.
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– Minimum/Maximum Calibration Voltage—The voltage level 

that BioBench records when you clicked on the Accept button. 

The shorter (blue) needle on the voltage meter indicates the 

value of the calibration voltage.

– Eng. Value—The minimum and maximum Engineering Values 

are initially the same as the values you entered in the Channel 

Configuration dialog box. You can change the values here, and 

these values will display as the Min (egu)/Max (egu) values on 

the Channel Configuration dialog box.

• Voltage Range—For best calibration results, select the voltage 

range that encompasses the expected voltage range of the signal.

• Linear Conversion—Contains a graph control and two indicators.

– Graph—The two data calibration points are graphed, with the 

voltage on the X axis and the engineering values on the Y axis.

– Gain (m), Offset (b)—These are the calculated values of m and 

b used in the linear fit equation Y = mX + b. See the Channel 

Configuration dialog box for more information.

• Help—This button opens a dialog box which has step-by-step 

instructions for performing a typical two-point calibration 

procedure.

• OK—Takes calibration voltages and engineering values you enter 

and displays them in the Channel Configuration dialog box, in the 

Signal Voltage Range and Engineering Scaling areas, respectively.

Configuring BioBench Settings for Acquisition
You can configure the timing, alarm, and output stimulus parameters of 

your acquisition in the dialog box that appears when you choose 

Configure»Settings in the data acquisition view.
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Configuring Timing of Data Acquisition
Timing configuration settings allow you to control the amount of data 

you collect and speed of data acquisition. To configure the timing of 

data acquisition, select Configure»Settings, and select the Timing tab 

in the dialog box that appears.

Figure 2-6.  Timing Tab, Configuration Settings for Acquisition Dialog Box

Descriptions of each control on the Timing tab of the Configuration 

Settings for Acquisition dialog box follow:

• Start Time, Manual—Sets BioBench to start acquiring data as soon 

as you click on the GO button in the data acquisition view.

• Start Time, After Specified Delay—Sets BioBench to delay data 

acquisition for a specified time after you click on the GO button in 

the data acquisition view.

• Start Time, On Trigger—Sets BioBench to delay data acquisition 

until a trigger condition occurs after you click on the GO button in 

the data acquisition view.

Remember the following details about setting start time for a 

trigger. You select a Trigger Signal from the pull-down list. Enter 

the trigger level in the Trigger Level box. The acquisition begins 

when the Trigger Signal exceeds the trigger level.
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• Stop Time, Manual—Sets BioBench to stop data acquisition when 

you click on the STOP button in the data acquisition view.

• Stop Time, After Specified Duration—Sets BioBench to 

automatically stop an acquisition after the specified time elapses.

• Sample Rate—Select the sample rate from this pull-down list. The 

maximum sample rate is 1,000 samples per second (Hz). If you set 

a sample rate below 200 Hz, the notch filter is disabled during data 

acquisition. 

• Notch Filter Frequency—Select the noise frequency, 50 or 60 Hz, 

that you would like to attenuate, given a sample rate of 200 Hz or 

greater. The Notch Filter Specifications section in Chapter 3,  

Acquiring Data, describes the notch filter.

• Scan List—Shows the signals configured in the Channel 

Configuration dialog box or available in the data file you are 

replaying. You highlight the signals in the Scan List that you would 

like to acquire. Click on the Select All button to select all signals.

When you select Start Time, On Trigger, a diamond appears to the 

left of the signal which you selected in the trigger signal pull-down 

list.

If the data source is a file, you cannot change the selected signals.

• Approximate Free Disk Space—Displays the amount of free disk 

storage space you have available for your data files. You specify 

the disk for data logging in the dialog box that appears when you 

select File»Logging in the data acquisition view. 

• Approximate Data File Size/Approximate File Growth Rate—

These indicators help you monitor file size or growth rate.

– When you select Stop Time, After Specified Duration, the 

indicator displays the Approximate Data File Size, based on 

the number of signals in the Scan List, Sample Rate, and 

duration of acquisition.

– When you select Stop Time, Manual, the indicator displays the 

Approximate File Growth Rate, based on the number of signals 

in the Scan List and Sample Rate.

Configuring Alarms
Alarm settings allow you to receive automatic notification when your 

signals go out of the range you specify. To configure alarms, select 

Configure»Settings, then select the Alarms tab in the dialog box that 

appears. The Configuring Timing of Data Acquisition section of this 
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chapter describes the indicators at the bottom of the dialog box: 

Approximate Free Disk Space, Approximate Data File 

Size/Approximate File Growth Rate.

Figure 2-7.  Alarms Tab, Configuration Settings for Acquisition Dialog Box

Descriptions of each control on the Alarms tab of the Configuration 

Settings for Acquisition dialog box follow:

• Alarms Enabled?—Use this checkbox to quickly enable or disable 

all existing alarms. To configure alarms, you must check this box.

• Signals—This list shows all the signals configured in the Channel 

Configuration dialog box. When you select a signal in the list, the 

alarm settings for that signal appear at the right. 

• Alarm Setup Parameters—Use this group of controls to set alarm 

parameters. You can set up alarms for each signal in the 

Signals list.

– Label—Enter an alarm label for the selected signal in this field. 

This label appears on the data acquisition view when the alarm 

condition occurs, if the signal is being displayed on a graph.



Chapter 2 Setting Up Your System

BioBench User Manual 2-16 © National Instruments Corporation

– Alarm Type—Select one of the following alarms: No Alarm, 

Below Min, Above Max, Inside Range, or Outside Range.

– Min, Max—Specify minimum and/or maximum to define the 

level or range for the alarm.

Defining an Output Stimulus 
Output stimulus settings allow you to configure the characteristics of an 

analog output signal that you can use during data acquisition. To define 

or select an analog output stimulus, select Configure»Settings, then 

select the Stimulus tab in the dialog box that appears. The Configuring 

Timing of Data Acquisition section of this chapter describes the 

indicators at the bottom of the dialog box: Approximate Free Disk 

Space, Approximate Data File Size/Approximate File Growth Rate.

Figure 2-8.  Stimulus Tab, Configuration Settings for Acquisition Dialog Box
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Descriptions of each control on the Stimulus tab of the Configuration 

Settings for Acquisition dialog box follow:

• Stimulus Method, None—Specifies no stimulus. This is the default 

selection.

• Stimulus Method, Front Panel Manual Control—BioBench 

provides a fixed DC level output of either the Off Voltage or the On 

Voltage you specify in the controls shown in Figure 2-8.

– Off Voltage—While you are not clicking and holding down the 

OUT button during an acquisition, BioBench sets the analog 

output channel 0 of your DAQ hardware to the Off Voltage.

– On Voltage—While you click and hold down the OUT button 

during an acquisition, BioBench sets your DAQ hardware’s 

analog output channel 0 to the On Voltage.

Note: When you turn the stimulus on or off using the OUT button, BioBench 

records a stimulus event in the journal if you are logging data to disk.

• Stimulus Method, User-Defined Waveform—BioBench can 

generate an analog output stimulus waveform through the analog 

output channel 0 of your DAQ hardware. The stimulus can be a 

pulse or an arbitrary waveform in a file. With either choice, 

BioBench begins the analog output (stimulus) as soon as data 

acquisition begins. The A Point to Remember When You Set Up a 

Stimulus section, later in this chapter, gives more details on setting 

up stimulus.

– Stimulus Type, Pulse—Defines a pulse waveform for analog 

output stimulus. A graphical representation of the pulse 

waveform appears in the Stimulus Waveform graph. The pulse 

waveform is initially off for the time you specify and then turns 

on for the time you specify. Figure 2-9 shows the controls that 

appear when you select this option:

• Off Voltage—Specifies the voltage level of the pulse 

waveform in the off state.

• On Voltage—Specifies the voltage level of the pulse 

waveform in the on state.
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• Off Time—Specifies the amount of time the pulse 

waveform remains in the off state before changing to the 

on state.

• On Time—Specifies the amount of time the pulse 

waveform remains in the on state before proceeding to the 

next waveform cycle.

Figure 2-9.  Configuring a Stimulus Pulse

Note: You cannot define a pulse waveform longer than 10,000 points. Because 

BioBench issues the data waveform at 100 points per second, the maximum 

pulse duration is 100 seconds.

– Stimulus Type, From File—You can select an arbitrary 

waveform from file for analog output stimulus. A graphical 

representation of the arbitrary waveform appears in the 

Stimulus Waveform graph. You can click on the Browse button 
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to select a data file that contains the arbitrary waveform. 

Figure 2-10 shows the controls that appear when you select 

this option.

Figure 2-10.  Using a Stimulus from a File

For Stimulus Type, From File, the file you select must contain the 

voltage waveform data in an ASCII, tab-delimited format. The data 

values must be between –10 VDC to +10 VDC. BioBench only uses the 

first column of data. For example, a five-second stimulus waveform 

would be represented by a single column of 500 numbers in an ASCII, 

tab-delimited file.

Note: BioBench uses only the first column and the first 10,000 rows in the 

stimulus file.

At the bottom of the Stimulus tab, you can specify how many 

times BioBench repeats the pulse or waveform from file.

• # Repetitions, Continuous—The waveform repeats until 

data acquisition stops.

• # Repetitions, Number—The waveform repeats the 

specified number of times.
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A Point to Remember When You Set Up a Stimulus

BioBench issues the stimulus waveform at 100 points per second 

through the analog output channel 0 only when data acquisition is in 

progress. Stimulus is not issued when BioBench is waiting on a delay 

or waiting for a trigger condition to occur.

Note: You cannot define a pulse waveform longer than 10,000 points. Because 

BioBench issues the data waveform at 100 points per second, the maximum 

pulse duration is 100 seconds.
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Entering Vendor Information
You can enter information about the vendors of your physiological 

monitoring instruments and amplifiers in a database within BioBench. 

To open this database, select Configure»Vendors. You also can open it 

by clicking on the Vendor Database button in the Channel 

Configuration dialog box (Figure 2-4). Figure 2-11 shows the Vendor 

& Device Database Maintenance dialog box.

Figure 2-11.  Vendor & Device Database Maintenance Dialog Box

The Vendor & Device Database Maintenance dialog box allows you 

to view, modify, add, and delete data about vendors and their various 

physiological monitoring devices and amplifiers.

A predefined database of equipment information comes with BioBench. 

You can append information to this database. For example, you can 

enter contact, address, and telephone information in addition to helpful 

tips or special instructions on how to use or configure a device. For each 
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device, you can enter the suggested default signal levels and other 

information to speed up the channel configuration procedure.

You can scroll through the vendors in the database to modify, add, or 

delete vendors. For any specific vendor, you can scroll through the 

devices for that vendor, and modify, add, or delete devices.

When you access the vendor database from the Channel Configuration 

dialog box, BioBench automatically uses the information from the 

selected vendor and device to configure the channel selected in the 

Channel Configuration dialog box. The vendor database passes the 

following configuration parameters to the Channel Configuration 

dialog box: Output Voltage, Min and Max; (engineering) Units, Min 

(egu) and Max (egu); and the Gain and Offset settings.

Testgroups

With BioBench, you can organize your data files into testgroups of 

similar data. For example, a professor might create two testgroups that 

correspond to two separate groups of students. You can also acquire 

data without associating the data to any particular testgroup, in which 

case you do not need to set up testgroups.

Using the Testgroup Setup dialog box, you can set the current testgroup, 

view all testgroups, and modify testgroup information. You can also 

view all data files associated with a specific testgroup, modify file 

information, and view events for a file.
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Setting Up Testgroups

To access the Testgroup Setup dialog box, select File»Testgroups. 

Figure 2-12 shows the Testgroup Setup dialog box.

Figure 2-12.  Testgroup Setup Dialog Box

The following controls appear in the Testgroup Setup dialog box:

• Testgroups—This list shows all testgroups BioBench recognizes. 

A bullet appears beside the current testgroup. Any acquisition you 

perform and log to disk is associated with the current testgroup you 

have selected. To select a different testgroup, highlight it and click 

on the OK button. 

• Delete—Deletes the selected testgroup.

• New—Allows you to create a new testgroup. Figure 2-13 shows the 

New Testgroup dialog box.

Figure 2-13.  New Testgroup Dialog Box

• Date, Time—This indicator shows the date and time when the 

testgroup was created.
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• Testgroup Notes—This text box shows the notes associated with 

the selected testgroup. You can enter new text or modify the text in 

this box.

• Show Data Files—Clicking on this button displays the Data File 

Summary dialog box, shown in Figure 2-14. The following section 

describes the Data File Summary dialog box in detail.

• OK—Makes the testgroup you selected the current testgroup and 

closes the Testgroup Setup dialog box.

Reviewing Data File Summary Information
This section describes the controls in the Data File Summary dialog box 

shown in Figure 2-14.

Figure 2-14.  Data File Summary Dialog Box

The following controls appear in the Data File Summary dialog box:

• Data Files—Displays the files that are in the \biobench\data 

directory and are associated with the testgroup that you select in the 

Testgroup Setup dialog box.

• Modify—Clicking on this button displays the Modify File 

Information dialog box shown in Figure 2-15, where you can view 

and modify some of the general information about the selected file.
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• Events—Clicking on this button displays the Data File Events 

dialog box shown in Figure 2-16, where you can view file events 

for the selected file.

• General Info—Displays information about the acquired data in 

this file. You can click on the Modify button to change some of this 

information.

Modifying Data File Information

You click on the Modify button in the Data File Summary dialog box 

to open the Modify Data File Information dialog box shown in 

Figure 2-15.

Figure 2-15.  Modify Data File Information Dialog Box

Use this dialog box to assign a different username to a file, to associate 

a different testgroup with a file, and to edit the notes associated with a 

file. The following controls appear in the Modify Data File Information 

dialog box:

• Existing Usernames—This list displays the usernames of users 

who have previously logged onto BioBench. A bullet appears 

beside the username of the person who is currently logged on.

• Existing Testgroups—This list displays the testgroups that 

BioBench recognizes. Refer to the Setting Up Testgroups section in 

this chapter for information on how to add or delete testgroups. A 

bullet appears beside the current testgroup. (BioBench associates 

any new data files with this testgroup.)



Chapter 2 Setting Up Your System

BioBench User Manual 2-26 © National Instruments Corporation

Note: If you want to assign a file to a testgroup that does not currently exist, you 

must first create that testgroup by using the New option in the Testgroup 

Setup dialog box. Refer to the Setting Up Testgroups section for more 

information.

• File Notes—These are the notes associated with the file. You can 

edit the notes in this box.

• OK—When you click on OK, the selected username, testgroup, 

and File Notes are associated with the file. 

Reviewing Data File Events

You click on the Events button in the Data File Summary dialog box to 

open the Data File Events dialog box shown in Figure 2-16.

Figure 2-16.  Data File Events Dialog Box 

Use this dialog box to review file events associated with a file. The 

following controls appear in the Data File Events dialog box:

• Data File—This is the filename which you selected in the Data File 

Summary dialog box when choosing to review events. 

• Testgroup—This is the testgroup which is associated with the data 

file. 

• List of Events—This list displays the files events which are 

associated with this file. Select an event from this list and the Time 

and Event Notes for this event are displayed to the right. 
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• Time—This is the time at which the event occurred during the 

acquisition. The Time value does not reflect any time that elapses 

while logging is turned off.

• Event Notes—These are the notes associated with the event. 

BioBench may have automatically generated these notes or a user 

may have created them during the acquisition. 

Note: You cannot modify events in this dialog box. Refer to the File and Search 

Events section of Chapter 4, Setting Up Your System, for information on how 

to modify file events or their associated notes.

After you set up your system you will be ready to read Chapter 3, 

Acquiring Data.
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Chapter

3Acquiring Data

This chapter gives instructions for acquiring data with BioBench after 

you have set up your system.

Before you begin acquiring data, make sure that your DAQ hardware is 

correctly installed and configured as described in Chapter 2, Setting Up 

Your System. 

If you do not have data acquisition hardware, you can use the 

demonstration/teaching data files in the \biobench\examples 

directory to simulate real-time data acquisition. See the Selecting a Data 

Source section of Chapter 2, Setting Up Your System, for more 

information on using the data files for demonstration and teaching.

Data Acquisition Views

All dialog boxes and controls in this chapter appear in or can be reached 

from the data acquisition views.

Using the View menu, you can select one of four data acquisition views 

to display data in real time:

• 2 Graph Acquisition—View one or two selected signals in 

two independent graphs.

• 4 Graph Acquisition—View up to four selected signals in 

four independent graphs.

• 8 Graph Acquisition—View up to eight selected signals in 

eight independent graphs.

• XY Graph Acquisition—View any two selected signals graphed 

with respect to time and each other. 
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The controls in all the acquisition views behave similarly and are 

described in this chapter. The XY view has additional capabilities that 

are described at the end of this chapter. All data acquisition views 

behave in the same way. Figure 3-1 shows the 4 Graph Acquisition 

view.

Figure 3-1.  4 Graph Acquisition View
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Starting Data Acquisition

To start acquiring data, click on the GO button. After you click on the 

GO button, BioBench checks its settings to determine when to begin 

acquiring and displaying data. For instance, BioBench can immediately 

begin collecting data, wait for a specified time delay before acquiring 

data, or wait for a trigger condition before acquiring data. For more 

information, refer to the Configuring Timing of Data Acquisition section 

of Chapter 2, Setting Up Your System.

Note: You cannot access the menu options during data acquisition (except the Help 

menu). However, you can turn data logging on or off, initiate trending, adjust 

graph speed, and create user events and notes in the data file during 

acquisition.

Pausing the Display

You can click on the Pause button to suspend the screen update. The 

Pause button is enabled only after you click on the GO button. The time 

scale below the graphs does not reflect any time that elapsed while in 

paused mode.

Note: When you click on the Pause button, BioBench suspends the screen 

update, but continues to log data to disk when logging is enabled.

Stopping Data Acquisition

You can stop data acquisition at any time by clicking on the STOP 

button. The STOP button is enabled only after you click on the GO 

button. Alternatively, you can configure BioBench to stop after a 

specified duration. For more information, refer to the Configuring 

Timing of Data Acquisition section of Chapter 2, Setting Up Your System.
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Producing a Manual Stimulus

You enable the OUT button by selecting Configure»Settings, then 

selecting the Front Panel Manual Control option in the Stimulus tab of 

the dialog box that appears.

When you click on and hold the OUT button, the analog output of the 

DAQ hardware is set to the On Voltage. When you are not clicking on 

and holding the OUT button, the analog output is set to the Off Voltage. 

You configure On Voltage and Off Voltage in the Stimulus tab of the 

Configuration Settings for Acquisition dialog box. 

Note: When you begin data acquisition, arbitrary waveforms and user-defined 

pulses start generating immediately after any delay or trigger condition is 

met. When you select User-Defined Waveform stimulus, the OUT button is 

disabled. To learn how to set up output stimulus waveforms, refer to the 

Defining an Output Stimulus section of Chapter 2, Setting Up Your System, for 

more information.

Controlling the Graph Speed

To control the speed at which data flows across the screen, use the 

Graph Speed pull-down list. This display is analogous to a strip chart 

recorder. For example, if you set the graph speed to five seconds, the 

graph fills up with five seconds of data before it is cleared. You can 

change the graph speed at any time during data acquisition.

The time axis at the bottom of each view indicates the amount of time 

that has passed since the beginning of data acquisition. This time does 

not reflect any time passed while the display is paused.
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Logging Data

This section describes the controls in the Logging area of the data 

acquisition views. BioBench allows you to log data and record events 

during acquisition. You can enable logging for an entire data 

acquisition episode or turn logging on and off intermittently. Turning 

off logging during data acquisition creates a Log Off event in the 

journal. The following controls appear in the Logging area.

• Log Data—Activates the recording of data to a file on disk. To stop 

recording, deselect this checkbox. When you check the Log Data 

box during an acquisition, BioBench prompts you for the filename, 

or creates a filename automatically, based on the settings in the 

File»Logging options. See the Logging Setup section of Chapter 5, 

Saving Data, for a description of the Logging Setup dialog box.

If you select this option while data acquisition is not in progress, 

BioBench does not determine the filename until you click on the 

GO button. 

After you begin acquiring data you can turn off data logging by 

unchecking the Log Data checkbox. You can click on the Log Data 

checkbox again to restart data logging. When you turn data logging 

on and off repeatedly during an acquisition (by selecting and 

deselecting the Log Data checkbox), data is appended to the same 

file.

• file—Displays the name of the data log file.

• Journal—Clicking on this button displays the BioBench electronic 

journal where you can enter file notes during data acquisition. The 

journal also displays all events associated with a file, such as 

stimulus, data log, and user-defined events. Figure 3-2 shows the 

Journal dialog box. The following controls appear in the Journal 

dialog box:

– File Notes—Displays any notes you wish to enter about the 

specific data file. You can edit this field each time you click on 

the Journal button.

– List of Events—Shows all the events that have occurred during 

the acquisition, along with the time at which the event 

occurred. You can click on any event to see the associated 

Event Notes and event type.

– Event Notes—Displays the notes associated with an event. 

You may have entered these notes using the User Event button 
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during acquisition, or BioBench may have entered these notes 

automatically.

– Type—Displays the type of event highlighted in the List of 

Events: user-defined, stimulus, or data log event.

Figure 3-2.  Journal Dialog Box

• User Event—Displays the Add User Event dialog box, as shown in 

Figure 3-3. This dialog box allows you to create user-defined 

events and notes during data acquisition. BioBench time-stamps 

each event and displays it in the Journal’s List of Events. The User 

Event button is enabled only when you are logging data to disk.

Figure 3-3.  Add User Event Dialog Box
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Trending

BioBench can show trends in your data, for example, computing heart 

rate over time from an ECG signal. If you enable trending, BioBench 

graphs the trend of your data according to the parameters you specify. 

You can display trending graphs only during data acquisition.

Enabling Trending
To enable trending, click on the pull-down list to display the names of 

all the signals currently displayed on the graphs. Select one of these 

signals to enable real-time trending. If you change the trending signal, 

BioBench resets the trend graph.

Setting up Trends
To set up trending, you must select the trend type from the pull-down 

list in the Trending area. The trending types are Min, Max, Mean, and 

BPM. If you change the trending type while you acquire data, BioBench 

resets the trend graph.

A numeric indicator displays the most recent trend value for the 

selected signal and the selected trend type. BioBench updates this value 

based on the screen update rate you define when you set up the trending 

feature as follows. 

Entering Trend Parameters
To enter trend parameters, click on the Setup button in the Trending 

area. Figure 3-4 shows the Trend Setup dialog box that appears.

Figure 3-4.  Trend Setup Dialog Box
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The following controls appear in the Trend Setup dialog box:

• Screen Update Rate—Sets how frequently BioBench calculates a 

trend value and updates the numeric screen indicator located just 

above the Setup button in the Trending area. 

• History—Sets how far back in time BioBench goes to calculate a 

trend value.

• Beat Per Minute (BPM) Calculations—This group of controls 

determines the frequency of a periodic signal, such as the heart rate 

frequency from an ECG. The data set is determined by the History 

setting specified above. The BioBench BPM algorithm first 

determines where the local maximums are in the data set. BioBench 

then counts the number of local maximums and divides that number 

by the History to obtain a rate value. (BioBench follows the same 

process when you choose Minimums, except that it looks for local 

minimums, rather than maximums.) The following controls appear 

in the BPM Calculations area:

– % Threshold—Sets BioBench to reject local maximums (or 

minimums) that are too small. BioBench determines the 

amplitude of the data set and obtains a threshold value by 

applying this percentage. The system ignores any maximums 

(or minimums) that do not meet this threshold level.

– Width—Specifies the number of consecutive data points to use 

in the quadratic least-squares-fit equation. BioBench uses this 

equation to locate the local maximums (or minimums). The 

default value is three. 

– Use Derivative?—Applies the first derivative to the trending 

signal and can help you minimize the effects of baseline 

drifting in your signal. 

– Mode (Minimums/Maximums)—Determines whether 

BioBench looks for local maximums or local minimums. This 

feature is useful when you are measuring heart rate from a 

number of ECG lead configurations.
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Viewing the Trend Graph
To view the trend graph, which shows the trend history of your acquired 

data, click on the Trend button in the Trending area. A graph showing 

the real-time trend values appears. Figure 3-5 shows the Trend Graph 

dialog box.

Note: BioBench resets this graph whenever you change the trend signal, the trend 

type, or the trend setup parameters. 

Figure 3-5.  Trend Graph

The trend graph may contain no more than 10,000 data trend points. 

After 10,000 points accumulate, BioBench begins removing the oldest 

data points as it calculates new data points. You use the Graph tool 

palette in the Trend Graph dialog box to adjust the display of your data. 

Refer to the Power Spectrum section in Chapter 4, Analyzing Data, for a 

description of the Graph tool palette.

Status Display

BioBench indicates the configured sample rate and the current status of 

the data acquisition: acquisition off, acquiring data, waiting on trigger, 

or waiting on delay. You can view the status control at the bottom, right 

of the acquisition view.

To set the sample rate, select Configure»Settings, then select the 

Timing tab in the dialog box that appears. 
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Switching to Analysis Mode

You can use the Analysis button as a quick and convenient way to 

switch from an acquisition view to an analysis view. (You can also 

switch to the analysis mode of BioBench by selecting any of the 

analysis views from the View menu.) If you have just saved data to disk 

and switch to analysis mode, the data that you just acquired is loaded 

automatically. The Analysis button is disabled during data acquisition. 

For more information about the analysis features, refer to Chapter 4, 

Analyzing Data.

Setting the Scale for a Graph

You can set the scale for a graph manually or automatically.

Automatically Setting the Scale
To automatically set the scale for a graph, click on the Autoscaling 

button. BioBench applies a scale to the data that best fits the data into 

the graph.

Manually Setting the Scale
To set the scale for a graph manually, click in the area to the left of the 

graph. The Set Acquisition Scale dialog box, shown in Figure 3-6, 

appears.

Figure 3-6.  Set Acquisition Scale Dialog Box

The following controls appear in the Set Acquisition Scale dialog box:

• Ymax/Ymin—Sets the minimum and maximum Y-axis values you 

want to use for the graph.

• # Decimals—Selects 0, 1, 2, or 3 for the number of decimals you 

want to use in the Y scale and in the digital display for the graph.
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Changing the Data for a Graph

BioBench can display any signal you are acquiring in the graphs of the 

data acquisition view. To select a channel to display on a particular 

graph, use the pull-down list in the upper left-hand corner of the graph. 

The pull-down list shows all the signals currently being acquired. This 

list consists of the signals selected in the Scan List of the Timing tab of 

the Configuration Settings for Acquisition dialog box. The Configuring 

Timing of Data Acquisition section of Chapter 2, Setting Up Your System 

explains how to configure the Scan List.

Note: You can change the signal that displays in a graph while you are acquiring 

data.

Digital Display

BioBench displays the instantaneous value for each signal in real time. 

The digital display and the engineering units (that is, mmHg, VDC, and 

so on) are centered above each graph.

Changing the Display Parameters

Legend—To change graph display parameters such as color, line width, 

fill options, and so on, click on the legend box above the graph. Changes 

affect only the graph below the legend. The line in the Legend box 

reflects the display parameters you selected.

Filtering Data

To filter data, click on the Filter radio button above the graph you want 

to filter. This option enables or disables filtering with a 50 or 60 Hz 

notch filter. The choice of filter type appears in the Timing tab of the 

dialog box that appears when you select Configure»Settings. The notch 

filter attenuates signal noise at the specified frequency.
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Note: The filtering feature is only enabled when the sample rate is 200 Hz or more.

Although the graph displays filtered data, all of the raw data is stored to 

disk so you can reanalyze the same data later using other types of filters 

and transformations, as described in the Applying Analysis Methods section 

of Chapter 4, Analyzing Data. 

Notch Filter Specifications
BioBench uses various IIR filter coefficients to implement the notch 

filter based on the sample rate and notch filter frequency selected. The 

tables below provide the IIR filter order, notch width, and attenuation 

for each of the six different notch filter scenarios. 

Sample Rate—You select sample rate in the Timing tab of the 

Configuration Settings for Acquisition dialog box. Notch filtering is not 

available when the sample rate is below 200 Hz.

IIR Filter Order—This number represents the number of IIR filter 

coefficients used to create the notch filter. Higher-order filters require 

more processing, but, in general, better meet the filter specifications of 

minimal notch width and maximum target frequency attenuation.

Table 3-1.  60 Hz Notch Filter Specifications

Sample Rate IIR Filter 

Order

Notch Width (-3 dB) 60 Hz Attenuation

200 Hz 4 59.2 to 60.8 Hz -74 dB

500 Hz 3 58.2 to 61.7 Hz -70 dB

1000 Hz 5 55.4 to 64.3 Hz -59 dB

Table 3-2.  50 Hz Notch Filter Specifications

Sample Rate IIR Filter 

Order

Notch Width (-3 dB) 50 Hz Attenuation

200 Hz 1 49.6 to 50.4 Hz -70 dB

500 Hz 5 47.5 to 52.1 Hz -63 dB

1000 Hz 4 45.5 to 54.2 Hz -75 dB
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Notch Width (-3 dB)—Indicates the frequency range where the notch 

filter is attenuating by three decibels or more.

50/60 Hz Attenuation—Indicates the decibel attenuation at the target 

frequency of the notch filter.

Viewing Alarm Information

You can set alarms to notify you if the data you are acquiring reaches 

or exceeds a specified level or range. The indicator at the left shows 

what a high temperature alarm looks like on the screen.

To view alarm information for a specific graph, click on the bell button 

for that graph. The Alarm Options Display for the corresponding signal 

appears. This dialog box displays the Alarm Label, Type, Minimum, 

and Maximum parameters that you previously chose in the Alarms tab 

of the dialog box that appears when you select Configure»Settings (see 

Figure 2-7). Figure 3-7 shows the Alarm Options Display dialog box.

Figure 3-7.  Alarm Options Display Dialog Box

Note: The Alarm Options Display dialog box only displays the alarm settings in use 

for an acquired signal. You cannot change the alarm settings in it. Refer to the 

Configuring Alarms section of Chapter 2, Setting Up Your System, for 

instructions on how to set and change alarm parameters. 
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XY Graph View

In the XY Graph view, you can display two signals plotted against one 

another. Figure 3-8 shows the XY Graph Acquisition view. The XY 

Graph view behaves like all the other acquisition views and has the 

additional features described in this section.

Figure 3-8.  XY Graph Acquisition View

• The pull-down lists for selecting signals appear beside the XY 

graph in the XY Graph view, not beside the time graphs.

• When you select the Autoscale options, BioBench applies a scale to 

the data that best fits the data to the XY graph.

• The XY Graph view contains the # Points to Display control. You 

can choose the number of points to display by typing a number in 

this field or by using the slide control above the field. The number 

of points is also translated into a time value (hh:mm:ss.sss), 

which depends on the sample rate of the data.
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As BioBench acquires new data, the XY display continues to add 

to the existing waveform until it reaches the Number of Points to 

Display. When the number of points to display is reached, 

BioBench adds data to the end of the existing waveform and 

removes data from the beginning.

After acquiring data as described in this chapter, refer to Chapter 4, 

Analyzing Data, to learn about data analysis features in BioBench.
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Chapter

4Analyzing Data

This chapter explains the ways you can analyze data in BioBench.

Preparing to Analyze Data

To get to the data analysis view from the data acquisition view, click on 

the Analysis button. You can also access a data analysis view through 

the View menu. After you save an acquisition to disk, BioBench 

automatically loads this data into the Analysis view you open. 

If you want to analyze a data file you have collected previously, you can 

open the file by selecting File»Open and then choosing the file from the 

File Open dialog box, shown in Figure 4-1.

Figure 4-1.  File Open Dialog Box

You use the controls in the File Open dialog box to browse for and 

select the file that contains the signals you want to display in the 

analysis view:

• General Info—Displays general information for the file you select, 

such as the creation date and time, sample rate, number of signals, 
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file length, user name, testgroup, and file notes. By default, the File 

Open dialog box displays data files found in the \biobench\data 

directory. 

• Browse—Invokes the File Dialog box where you can select a 

directory other than \biobench\data that contains the file you 

want to open. In the File Dialog box navigate to the directory you 

want, highlight the directory, and then click on the Select button.

• Append?—Allows you to open more than one data file at a time. In 

BioBench, you can display, compare, and analyze several signals 

from different files simultaneously. 

Note: The Append? checkbox is available when one data file is already open. 

Remember that the files you open all must have the same sample rate.

Selecting the Signal for a Graph
To change the signal being displayed, click on the label of a graph, 

which is in the upper left corner of each graph. The Select Signal dialog 

box opens, as shown in Figure 4-2. In the Overlaid Analysis view, the 

labels for up to eight signals appear on the right side of the screen.

Figure 4-2.  Select Signal Dialog Box
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Use the following controls to choose a signal to analyze:

• Signal Label—Displays the currently selected signal name. You 

can change this label to show a name on the graph that is different 

from the signal name. 

• List of Signals—Select the signal you want to display from this 

scrolling list. This list contains the names of the signals in all the 

files currently opened. When you open multiple files, each signal 

name is preceded by a sequential file indicator, that is, file 1, 

file 2, file 3, and so on. 

• Filename—Displays the name of the opened file that contains the 

selected signal.

• Open Files—If you want to select a signal from a new data file, 

click on this button to open the file. This button opens the File Open 

dialog box shown in Figure 4-1.

• Filtering and Transform—Refer to the Applying Analysis Methods 

section of this chapter for explanations of these controls.

Analysis Views

Using the View menu, you can select one of three analysis views:

• 2 Graph Analysis—View and analyze one or two selected signals 

in two independent graphs.

• 4 Graph Analysis—View and analyze up to four selected signals in 

four independent graphs.

• Overlaid Analysis—View and analyze up to eight selected signals 

overlaid on the same graph.

Note: Before you can view data in the analysis views, you must select a file from 

the File»Open menu or from the Select Signal dialog box. Refer to the 

beginning of this chapter for more information.

The controls and graphs in all the Analysis views behave similarly and 

are described in this chapter.
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Figure 4-3 shows what data looks like in the 4 Graph Analysis view.

Figure 4-3.  4 Graph Analysis View
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Figure 4-4 shows what data looks like in the Overlaid Analysis view.

Figure 4-4.  Overlaid Analysis View



Chapter 4 Analyzing Data

BioBench User Manual 4-6 © National Instruments Corporation

Selecting Data and Navigating Through Your Data
The following list describes several ways to select a subset of data in 

any analysis graph. BioBench highlights the regions you select in a 

lighter color.

• Click the mouse and drag the cursor over a region you want to 

select.

• Click on any two event markers in the Event Profiler to select the 

region between them. The Viewing Events section later in this 

chapter describes the Event Profiler.

• Click on the Select Entire Display button at the bottom of the graphs 

to select all visible data in the graph. 

Use the navigation buttons to scroll and jump back and forth through a 

data file. These buttons also allow you to view the entire data file with 

a single click or magnify a highlighted region of the data file. 

Descriptions of the navigation and selection buttons follow: 

• Magnify Selected Region—Click on this button to magnify the 

selected region of the data file.

• Jump Left—Click on this button to jump left toward the beginning 

of the file. The size of the jump is equal to the amount of time 

currently displayed on the graph, or to the beginning of the file, 

whichever is less.

• Scroll Left—Click and hold this button to scroll back toward the 

beginning of the data file.

• Full Scale—Click on this button to display the entire data file on the 

graph.

• Scroll Right—Click and hold this button to scroll forward toward 

the end of the data file.

• Jump Right—Click on this button to jump right toward the end of 

the data file. The size of the jump is equal to the amount of time 

currently displayed on the graph, or to the end of the file, whichever 

is less.

• Select Entire Display—Click on this button to select all the data 

displayed on the graph. (This button does not select all the data in 

the file.)
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Changing Time Scale and Scrolling through Your Data
In addition to the navigation buttons described in the previous section, 

you can also use one of the following methods to change the time scale 

of your graphs:

• Changing the X axis manually—To set the X scale (the time scale) 

manually, click on the scale tick marks at the bottom of the graphs. 

A dialog box appears where you can enter the starting and ending 

times of the data set that you want to view.

• Scroll Bars—Use the scroll bar below the graphs and shown in 

Figure 4-5 to change the scale of the graphs and to scroll 

throughout the data file. You can change the amount of time you are 

viewing in the display by clicking and dragging the ends of the 

scroll bar, or scroll to the right or left in time by clicking and 

dragging the middle of the scroll bar.

Figure 4-5.  BioBench Data Scrollbar

Changing the Y Scales
Use one of the following controls to change the Y scale of the graphs:

• Changing the Y axis manually—To set the Y scale for a graph 

manually, click on the scale tick mark to the left of the graph. The 

Set Analysis Scale dialog box appears. You can set the minimum 

and maximum Y-scale values, as well as the number of decimals to 

display. Refer to the Manually Setting the Scale section in Chapter 3, 

Acquiring Data for more information on how to set the scale 

manually.

• Autoscaling—To automatically set the scale for a graph, click on 

the Autoscaling button. BioBench applies a scale to the data that 

best fits the data into the graph.

• Scroll Bars—Use the vertical scrollbar to the left of each graph to 

change the Y scale of the graphs. You can change the amount of 

data you are viewing in the display by clicking and dragging the 

ends of the scroll bar, or scroll up and down by clicking and 

dragging the middle of the scroll bar. The vertical scroll bar 

behaves similarly to the horizontal scroll bar shown in Figure 4-5.
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Changing the Appearance of Graphs
To change graph display parameters such as color, line width, fill 

options, and so on, click on the legend of the graph. The line in the 

legend box reflects the parameters you selected for the graph.

Indicators of the Analysis View
Following are descriptions of all the indicators in the analysis view:

• Graph indicator bar—A light gray indicator bar appears at the top 

of each graph. Depending on whether you have assigned a signal to 

the graph and if you have selected a region of data, several 

indicators appear in this bar. The following indicators and options 

appear on the graph indicator bar:

– Signal label—This is the name of the signal that is displayed in 

the graph. Click on the label to open the Select Signal dialog 

box where you can apply and modify filters and transforms for 

the signal. (On the Overlaid Analysis view, click on the labels 

to the right of the graph to open the Select Signal dialog box.) 

Refer to the Selecting the Signal for a Graph section earlier in 

this chapter for more information.

– Engineering Unit—This indicator displays the engineering 

unit, such as mmHg, VDC, and so on, of the displayed signal.

– y1, y2—These indicators display the y value of markers one 

and two. y1 appears when you first click on the graphs. 

y2 appears when you select a region. (Marker 1 always appears 

on the left. Marker 2 always appears on the right.)

Note: In the Overlaid Analysis view, the indicators at the top pertain only to the 

selected signal. To select a signal in the overlaid analysis view, click on the 

radio button to the right of the signal labels on the right side of the screen.

• Filter/Transform Indicators—These indicators display any filter 

and/or transform option you have selected for the graph in the 

Select Signal dialog box, shown in Figure 4-2. Refer to the Selecting 

the Signal for a Graph section earlier in this chapter for an 

explanation of this dialog box.
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• Absolute and Relative Time indicators—The following indicators 

at the bottom of the graph display several time-related values: 

– Initial/Final Time—These indicators located at the far left and 

far right edges of the bottom graph display the starting and 

ending time of the portion of the data file currently displayed 

on the graphs in a standard format (hh:mm:ss.s).

– window view—This indicator displays the amount of time 

currently displayed on the graphs in a standard format 

(hh:mm:ss.s).

– x1, x2—These indicators display the time values 

(hh:mm:ss.s) associated with markers one and two, which 

define a highlighted region of data. x1 appears when you first 

click on the graphs. Then x2 appears when you drag your 

mouse and select a region. (Marker 1 always appears on the 

left. Marker 2 always appears on the right.)

– dx—This indicator displays the time interval between the two 

markers that define a highlighted region of data (x2 – x1).

– decimation factor—This indicator displays the decimation 

factor for the analysis graphs. When a large amount of data is 

displayed, BioBench decimates the data set to display 5,000 

points on each graph. Decimating the data makes data selection 

and scrolling more efficient in BioBench. 

Decimation is only implemented when you try to view more 

than 5,000 points on a graph.

• File indicator—Located in the lower right corner of the view, this 

area displays the data file you are currently viewing and analyzing. 

If multiple files are open, BioBench displays only the selected file 

(and its sequential number). Refer to the Displaying File Information 

section later in this chapter for instructions on how to select one file 

if multiple files are open.

Returning to the Acquisition View
You can use the Acquisition button as a quick and convenient way to 

switch from an analysis view to an acquisition view. (You can also 

switch to the acquisition mode of BioBench by selecting any of the data 

acquisition views from the View menu.) 
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Applying Analysis Methods

The Select Signal dialog box, shown in Figure 4-2, allows you to 

choose analysis methods for your data. You can open the Select Signal 

dialog box by clicking on the signal label for a graph. The Selecting the 

Signal for a Graph section earlier in this chapter describes how to select 

signals. This section describes the analysis methods of the filters and 

transforms.

Note: You can perform one filter and/or one transform operation on any signal. 

When you perform both a filter and a transform operation, BioBench filters 

the entire data set before calculating the transform. 

Filtering
Choose the type of filtering you want to use from the Filtering 

pull-down list. The following filter options are available:

• No Filter—Applies no filter to your data.

• Digital Filter—Applies a third-order Butterworth filter of your 

choice: Lowpass, Highpass, Bandpass, or Bandstop. You enter the 

desired low and high cutoff frequencies.

• Median Filter—Applies a median filter over the number of seconds 

you define.

• 50-60 Hz Notch Filter—Applies your choice: a 50 Hz or 60 Hz 

notch filter. These notch filters have the same specifications as 

those described in the Notch Filter Specifications section of 

Chapter 3, Acquiring Data.

Transforming
Transforms help you analyze data by allowing you to create a new 

signal derived from an existing signal. For example, you can transform 

an ECG signal into a heart rate by applying the BPM transform. Choose 

the type of transform you want to use from the Transform pull-down 

list. The following transforms are available.

• No transform—Applies no transform to your data.

• Minimum—For each point in the data set, BioBench calculates a 

new point by finding the minimum value for the preceding number 

of seconds you specify.
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• Maximum—For each point in the data set, BioBench calculates a 

new point by finding the maximum value for the preceding number 

of seconds you specify.

• Mean—For each point in the data set, BioBench calculates a new 

point by finding the mean value for the preceding number of 

seconds you specify.

• Beats Per Minute (BPM)—Employs a beat-detection algorithm to 

create a signal that profiles the number of beats per minute, as in a 

heart rate, from an ECG signal. To apply this transformation, enter 

the following parameters: the percent threshold, the width, whether 

you choose to apply the derivative to reduce baseline drift, and 

whether you want to use local minimum or maximum values to 

determine BPM. For more specific information, refer to the 

Entering Trend Parameters section in Chapter 3, Acquiring Data.

• Standard Deviation—For each point in the data set, BioBench 

calculates a new point by finding the standard deviation for the 

preceding number of seconds you specify.

• Simple Expressions—Creates a new signal by adding, subtracting, 

multiplying, or dividing the selected signal with a user-defined 

constant or any other signal that you can select from an open file. 

(When you perform division with a divisor of zero, BioBench uses 

zero as the result.)

• Derivative—Creates a new signal that is the first derivative of the 

selected signal.

• Integral—Creates a new signal that is the integral of the 

selected signal.

Scalar Analysis
After you have selected a signal and applied the filter or transform you 

want, you can select a subset of the data on the graph and perform scalar 

analysis on that subset.

Use the Scalar Analysis pull-down list on the analysis view to select the 

type of scalar analysis you want to perform on the selected data. Notice 

that the analysis types here all yield scalar values. Scalar analysis 

results appear to the right of the analysis pull-down list.
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The following options appear in the Scalar Analysis pull-down list:

• No analysis—This option does not display any calculations.

• Minimum—This option displays the minimum value for the 

selected region.

• Maximum—This option displays the maximum value for the 

selected region.

• Mean—This option displays the mean value for the selected region.

• Delta Y—This option displays the difference between the y values 

for each of the markers defining the selected region (y2 – y1).

• Standard Deviation—This option calculates and displays the 

standard deviation for the selected region.

• Slope—This option calculates and displays the slope of the line 

defined by the two y values for each of the markers.

• Integral—This option calculates and displays the integral of the 

selected region.

Array Analysis
After you have selected a signal and applied the filter or transform you 

want, you can select a subset of the data on the graph and perform array 

analysis on that subset.

You can perform four types of array analysis on selected data: 

Histogram, Power Spectrum, Peak/Valley Detection, and XY Analysis. 

Complete the following steps to perform array analysis on your data:

1. Select the entire data set or a subset of data in the displayed graphs. 

The Array button becomes active when you highlight data. 

2. Click on the Array button to the right of the graph of the signal that 

you want to perform array analysis on. The Array Analysis dialog 

box shown in Figure 4-6 appears. The label of the signal you are 

analyzing appears in the Signal Label display.

3. Select a type of analysis by clicking on the appropriate tab.

Note: The numeric precision for the selected graph is passed into the array analysis 

options.

The following sections describe each tab in the Array Analysis dialog 

box.
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Histogram
The Histogram tab creates a histogram of the selected data set, as shown 

in Figure 4-6.

Figure 4-6.  Histogram Tab, Array Analysis Dialog Box

You can specify the number of bins and click on the Recalculate button 

to update the histogram and table.

You can use the vertical cursor to select any histogram bin. A blue outline 

then appears around the corresponding row in the Histogram Table. The 

Histogram Table numerically displays the value, count, and relative 

percentage of each bin number. In addition, the total count appears at the 

bottom of the table.

You can click on the Print button to print the Histogram tab.
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Power Spectrum
The Power Spectrum tab calculates a power spectrum of the selected 

data set, as shown in Figure 4-7. 

Figure 4-7.  Power Spectrum Tab, Array Analysis Dialog Box

You can select from a number of pull-down lists to configure the 

window, unit, and Y-axis display mode, which BioBench uses in the 

calculation and display of the power spectrum.

You can also define the frame size (from 128 to 8,192) for the power 

spectrum. BioBench calculates the entire power spectrum by iteratively 

calculating the power spectrum on portions of the data set of size equal 

to the frame size. The displayed result is the mean of all previously 

calculated power spectra. After selecting the desired configuration, 

click on the Recalculate button to update the graph, Estimated Power 
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Peak, and Estimated Frequency Peak. The following controls appear in 

the Power Spectrum tab:

• Window—Specifies the windowing function to apply when 

calculating the power spectrum.

• Display Unit—Specifies the output unit for the power spectrum.

• Log/Linear—Specifies linear or log mode for the Y axis.

• Frame Size—Number of points used in the power spectrum 

calculation. The frame size is always a power of two.

• Resolution—The degree of accuracy you can expect in terms of 

Hertz. Resolution is defined as Frame Size/Sample Rate.

• Sample Rate—The rate at which data was acquired. For example, 

100 Hz = 100 samples per second.

• Est. Power Peak—Indicates the estimated power of the peak in the 

power spectrum.

• Est. Frequency Peak—Indicates the estimated frequency of the 

peak in the power spectrum.

• Legend—Refer to the Changing the Appearance of Graphs section 

of this chapter to learn how to use the Legend control.

• Recalculate—Click on this button to recalculate the display.

• Print—Click on this button to print the Power Spectrum tab.

• Graph Tool Palette—You use the Graph tool palette to adjust the 

display of your data.

– x and y Autoscaling Buttons—When you click on the x 

autoscale button BioBench autoscales the X-axis data of the 

graph. When you click on the y autoscale button BioBench 

autoscales the Y-axis data of the graph. If you want the graph 

to autoscale continuously, click on the lock switch to the left of 

each button. In the graphic to the left of this paragraph, the lock 

is on for autoscaling in the X axis.

– x.xx and y.yy Scale Format Buttons—The scale format buttons 

give you run-time control over the numerical format of the 

X and Y axis respectively.

– Zoom Tool—When you click on the Zoom tool you can drag a 

selection rectangle around a section to see more detail. When 

you click on the Zoom tool, a pop-up list appears where you 

can choose a zooming method. 
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– Panning Tool—When you click on the Panning tool you can 

scroll the visible data by clicking and dragging sections of the 

graph.

– Mode Button—While this button is selected, you can click and 

drag cursors within a graph. 

Peak Detection
The Peak Detection tab allows you to determine peaks or valleys (local 

maximum or minimum values) within the selected data set as shown in 

Figure 4-8. 

Figure 4-8.  Peak Detection Tab, Array Analysis Dialog Box

BioBench indicates the location of the peaks or valleys by placing a red 

dot at the peaks or valleys. A horizontal cursor allows you to change the 

threshold level. BioBench ignores peaks less than the threshold, and 

ignores valleys greater than the threshold. You can use one or two 

vertical cursors to select any detected peak or valley. A blue or green 
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outline then appears around the corresponding row in the Peak/Valley 

list. The following controls appear in the Peak Detection tab:

• Mode—BioBench finds the peaks (local maximums) or valleys 

(local minimums).

• Width—Specifies the number of consecutive data points to use in 

the quadratic least squares fit. The value should be no more than 

one half of the half-width of the peak or valley and no less than two 

for noise-free data. Large widths can reduce the apparent amplitude 

of peaks and shift the apparent location.

• dx—If you place the two vertical cursors on two different peaks or 

valleys, dx shows the difference in time between the two cursors 

(the green and the blue cursor).

• dy—If you place the two vertical cursors (one green, one blue 

cursor) on two different peaks or valleys, dy shows the difference 

in Y values between the two peaks or valleys.

• #Found—The number of peaks or valleys BioBench finds, given 

the Mode, Width, and the threshold of the horizontal cursor.

• Peak/Valley List—A numeric list of all the peaks or valleys 

BioBench finds, given the Mode, Width, and the threshold of the 

horizontal cursor.

• Print—Click on this button to print the Peak Detection tab.

• Graph Tool Palette—Refer to the Power Spectrum tab discussion 

for information on the Graph tool palette.
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XY Analysis
The XY Analysis tab allows you to graph and analyze two independent 

signals with respect to one another, as shown in Figure 4-9. 

Figure 4-9.  XY Analysis Tab, Array Analysis Dialog Box

The pull-down lists at the top and bottom of the graph contain a list of 

all signals being displayed in the analysis view. Use these pull-down 

lists to select a signal to graph on each axis. The top list selects the data 

for the Y axis, and the bottom list selects the data for the X axis. 

Several regression analysis options are available for XY graphs. 

Specifically, you can perform a linear, exponential or polynomial fit to 

any XY graph. The parameters for display of the best fit data appear in 

the Legend control, the item labelled Fit in Figure 4-9.

The Cursor Navigation area allows you to scroll the red XY cursors 

through the data on the graph and indicates the respective X and Y 
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coordinate values. Alternatively, you can use the mouse to select the 

cursors directly on the graph and move them.

The following controls appear in the XY Analysis tab:

• Regression Analysis—Area where you set the parameters for 

regression analysis.

– Linear—Calculates and graphs a linear fit to your data. 

Calculates the slope, intercept and mean-squared error (mse) of 

the linear fit.

– Exponential—Calculates and graphs an exponential fit to your 

data. Calculates the amplitude, damping, and mean-squared 

error of the exponential fit. 

– Polynomial—Calculates and graphs a polynomial fit to your 

data based on the polynomial signal order that you enter. 

Calculates the coefficients and mean-squared error of the 

polynomial fit.

• Signal selectors—Use these pull-down lists to select a signal for 

each axis. You can use these controls to invert the graph.

• Cursor Navigation—Area where you control cursor position.

– X value—The x value of the vertical cursor.

– Y value—The y value of the horizontal cursor.

– Arrow controls—Use these controls to move the XY cursors 

across the graph.

• Legend—Refer to the Changing the Appearance of Graphs section 

of this chapter to learn how to use the Legend control. The first item 

in the legend is the graph of X versus Y (white by default). The 

second item is the best fit data set (yellow by default), which is 

shown when you choose a type of regression analysis.

• Graph Tool Palette—Refer to the Power Spectrum tab discussion 

for information on the Graph tool palette.

• Print—Click on this button to print the XY Analysis tab.
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File and Search Events

BioBench uses two classes of events: file events and search events. 

BioBench generates file events during data acquisition and these events 

can be any of three types: user-defined events, stimulus events, or 

datalog events. Search events mark specific times in the data file, as 

defined by criteria which the user enters. In the analysis views, you can 

view file events saved during data acquisition, add, delete, and modify 

file events, and define search criteria to create search events. 

Descriptions of all event types appear in the following section.

Viewing Events
The bar at the top of the analysis views is called the Event Profiler as 

displayed in Figure 4-10. The profiler can display either file events or 

search events. 

When you display file events, the Event Profiler shows file events 

associated with the file being analyzed. If more than one file is open, 

BioBench displays file events for only the selected file. Refer to the 

Displaying File Information section later in this chapter for information 

on how to select a file.

When you display search events, the Event Profiler shows the search 

events that are associated with one of the signals that is being displayed 

on one of the graphs.

Figure 4-10.  Event Profiler

• Event Profiler—Graphically profiles file or search events. All 

events are time stamped and color coded. The vertical lines that 

appear on the Event Profiler are called event markers. There are 

three colors of event markers to represent file events: 

– User-Defined Events (Yellow)—Events you define during 

acquisition or analysis. You can create, modify, and move 

user-defined events by clicking on the Event+ or Event 

buttons.

– Stimulus Events (Green)—Indicates when a manual analog 

voltage (stimulus) begins and ends.
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– Datalog Events (Blue)—Indicates when you stopped data 

logging during an acquisition.

There are two colors of event markers that appear on the Event 

Profiler to represent the two types of search events:

– Search Criteria Met (Red)—Indicates the points that 

BioBench found in the data that meet the search criteria. 

BioBench does not show search events for consecutive points.

– Search Criteria Not Met (Green)—Indicates the points that 

BioBench found in the data that do not meet the search criteria. 

BioBench does not show search events for consecutive points.

• File Event/Search Event Selector—Click on these buttons to 

display file events or search events in the Event Profiler. Continue 

to the next section for more information about file and search 

events.

Viewing or Changing File and Search Events
You can view and change information for file events, and define search 

criteria for search events. When you click on the Event button in the 

Analysis view, the Event List & Search Criteria dialog box, shown in 

Figure 4-11, appears.

Figure 4-11.  File Events Tab, Event List & Search Criteria Dialog Box
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The following controls appear in the File Events tab:

• Open Files—A list of all the open data files. When you select a file, 

the file events associated with that file appear in the Event List and 

the Event Profiler. An asterisk beside a file name indicates that 

changes have occurred in the data file. See Chapter 5, Saving Data, 

for more information on saving your data.

• Event List—Indicates the time that a file event occurred and the 

type of file event. When you select an event, the arrow above the 

Event Profiler jumps to the corresponding event marker and the 

notes associated with the event appear in the Event Notes field. A 

checkmark to the left of the time in the Event List indicates that you 

selected this event in the Analysis view. A trash can icon to the left 

of the time in the Event List indicates that you have selected this 

event for deletion, using the Delete button.

• Event Notes—Shows any notes associated with an event. You can 

edit the text in this field.

• Delete—Marks for deletion the event that is highlighted in the 

Event List. When you click on this button, a trash can icon appears 

to the left of the event in the Event List. When you click on the OK 

button, BioBench deletes any events you have marked for deletion.

• Event Profiler—The Event Profiler in this dialog box works like 

the Event Profiler for Analysis views (refer to the Viewing Events 

section of this chapter). However, this Event Profiler shows only 

file events, and it shows events for the entire data file, not for only 

a section of the data file.

Note: When multiple files are open, the Event Profiler displays only file events 

for the file you select in the Open Files list.

• Arrow control—You can click and drag the arrow above the Event 

Profiler to any event marker; the corresponding file event is 

highlighted in the event list.

In addition to file events, you can also define a wide variety of search 

events. Use search events to select any of the displayed signals and to 

locate special conditions in the signal, as defined by the search criteria. 

For example, Figure 4-12 displays search criteria that will generate 
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search events whenever the pressure signal rises above 150 mmHg and 

then falls below 150 mmHg.

Figure 4-12.  Search Criteria Tab, Event List & Search Criteria Dialog Box

The following controls appear in the Search Criteria tab:

• Displayed Signals—A list of all the signals displayed on the 

analysis view.

• Search for:—You can select any of the search types: Below 

Minimum, Above Maximum, Inside Range, or Outside Range.

• Min/Max:—Enter the values you would like BioBench to search 

for.

Adding New Events
You can add new, user-defined file events to your data files during 

analysis.

• Event+—Allows you to add a new, user-defined file event to the 

file. When you click on this button, the Add User Event dialog box, 

shown in Figure 4-13, appears.

After you enter any notes you want for this new event, a yellow 

event marker appears in the center of the Event Profiler on the 

Analysis view. As with any user-defined file event, you can drag 

the event and place it anywhere in the Event Profiler. 
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If multiple files are open, BioBench adds the events you create to 

the currently selected file. The Displaying File Information section 

in this chapter describes how to select one file when multiple files 

are open.

Figure 4-13.  Add User Event Dialog Box

Viewing and Changing Data File Information

BioBench allows you to view and change general information 

associated with each data file.

Displaying File Information
You click on the Info button in an Analysis view to display acquisition 

and file information for all open files. General information includes: 

creation date and time, sample rate, number of signals, file length, user 
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name, testgroup, and any notes associated with the file. Figure 4-14 

displays the Open File Information dialog box.

Figure 4-14.  Open File Information Dialog Box

The following controls appear in the Open File Information dialog box:

• Open Files—A list of all the open data files. An asterisk beside a 

file name indicates that changes have occurred in the data file. See 

Chapter 5, Saving Data, for more information on saving your data. 

When you select a file, the General Info associated with that file 

appears. Click on the OK button after highlighting a file to make 

the signals from that file available for analysis and event searching.

Note: When multiple files are open, the Event Profiler in the Analysis views 

displays only file events for the file you select in the Open Files list.

• General Info—Displays information about the file. You can 

change some of this information using the Modify button.

• Modify—Opens the Modify Data File Information dialog box, 

which is described in the Modifying Data File Information section of 

Chapter 2, Setting Up Your System. Use this dialog box to assign a 

different username to a file, to associate a different testgroup with 

a file, and to edit the notes associated with a file.
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Chapter

5Saving Data

This chapter explains how to record and save your BioBench data.

Logging Data

BioBench allows you to log data to a file during data acquisition. You 

can then read and analyze the file in BioBench’s Analysis mode or play 

the data back in simulated real time, in BioBench’s Acquisition mode.

Note: To maximize its efficiency in reading and writing data (and to reduce the hard 

disk space required for file storage), BioBench stores its data files and 

associated header information in a binary format. However, BioBench also 

gives you the option to export data to a standard ASCII text format that you 

can read with spreadsheet or word processor applications. 

Enabling Logging
To enable logging, check the Log Data checkbox in the data acquisition 

view. If you enable logging during an acquisition, BioBench creates a 

file and begins storing data to the file. If you enable logging while you 

are not acquiring data, BioBench waits until you click on the GO button 

to create a new file. The filename depends on the settings you selected 

in the Logging Setup dialog box. The Logging Setup section later in this 

chapter describes these settings. When you turn data logging on and off 

repeatedly during an acquisition (by selecting and deselecting the Log 

Data checkbox), BioBench appends data to the same file. 
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Logging Setup
To configure the settings for data logging, select File»Logging. The 

Data Logging Setup dialog box, shown in Figure 5-1, appears.

Figure 5-1.  Data Logging Setup Dialog Box

Descriptions of each of the controls on the Data Logging Setup dialog 

box follow:

• Prompt each time—Tells BioBench to prompt you for a filename 

each time a data file is created.

• Autonaming, no prompt—Tells BioBench to automatically 

determine the filename, each time a data file is created. BioBench 

creates the file in the directory specified by the Base Path field. In 

this mode, you must enter a Base Name. BioBench automatically 

creates a filename with a sequence number appended to the base 

name. 

For example, if the base name is BlueFly, BioBench creates data 

log files with filenames BlueFly, BlueFly001, BlueFly002, and 

so on. 

• Base Name—Applies only when Autonaming is on. This is the 

name of the file before BioBench adds a sequence number.

• Base Path—The directory where BioBench creates a log file, 

regardless of whether Autonaming is selected.
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• Browse—Displays the File Dialog box which allows you to select 

or create a desired directory for the base path. Figure 5-2 shows the 

File Dialog box.

Figure 5-2.  File Dialog Box

Exporting Data

To export selected data to a spreadsheet from any analysis view, select 

File»Export to Spreadsheet. The Export Data dialog box, shown in 

Figure 5-3, appears. 

Figure 5-3.  Export Data Dialog Box
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You can export only the data that is highlighted in the graphs. If you 

need to export all of the data for a given signal, complete the following 

steps:

1. Click on the Full Scale button to display the entire file. 

2. Click on the Select Entire Display button to highlight the entire 

displayed signals.

3. Select File»Export to Spreadsheet to export the data.

The following controls appear in the Export Data dialog box:

• Signals—This list box contains all the signals displayed in the 

analysis view. By default, all of the signals are selected. You can 

<Shift>-click on each signal name to select or deselect it.

• Export File Path—This indicator displays the target directory and 

filename for the export data file. All export data files receive the 

default extension, .txt. To change the data filename or directory, 

click on the Browse button.

• Export Header Notes—This text field allows you to enter any 

header notes you want to include in the exported data file. These 

notes will appear at the beginning of the exported data.

• Include Events?—This option includes file event information from 

all open data files in the exported data file. The type, time, and any 

notes associated with the events are included. Search events do not 

appear in the export file.

• Append?—If the Export File Path already exists on your computer 

disk, this option allows you to append exported data to the existing 

file, rather than replacing the file.

• Browse—This button allows you to select or create a file to receive 

exported BioBench data.

• Cancel—This button cancels the export option and returns you to 

the analysis view.

• Export—Click on this button to export the selected signals to the 

file selected in the Export File Path.

Note: When BioBench is displaying decimated data in the Analysis view, it will 

export the decimated data. The decimation factor appears in the Analysis view 

and in the header information of the exported data. If you choose to view more 

than 5,000 points in the Analysis view, BioBench decimates the data to 

improve screen update rates.



Chapter 5 Saving Data

© National Instruments Corporation 5-5 BioBench User Manual

Format of Exported BioBench Data
Figure 5-4 illustrates the format of exported BioBench data as it appears 

in Microsoft Excel. Vertical arrows denote a continuing series of data. 

Figure 5-4.  Sample Data File Exported to a Spreadsheet Application
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The following sections appear in an exported data file:

• BioBench Version—Indicates the version of BioBench that 

exported the data. The following items describe the parameters in 

the BioBench Version area:

– Export Notes—The Export Header Notes that you typed in the 

Export Data dialog box.

– Sample rate—Indicates the sample rate used to acquire 

the data.

– Decimation—Indicates the decimation factor BioBench used 

to display and to export the data.

• Data File Info—Contains the following information regarding each 

currently opened data file:

– File Name—Displays the path and filename of the data file.

– Testgroup—Displays the testgroup, if any, the data file is 

associated with.

– Username—Displays the name of the user who acquired the 

data.

– Creation Date—Shows the creation date of the data file.

– Creation Time—Shows the creation time of the data file.

– Data File Notes—Contains any notes which are associated with 

the data file.

– Number of Events—Shows the number of file events that the 

data file contains. BioBench includes the events in the export 

file when you select the Include Events? option in the Export 

Data dialog box. BioBench does not export search events.

– Start Events/End Events—Displays file events that are 

associated with the data file. Each event is time-stamped and 

includes its event type and event notes. 

• Signals—The following items describe the parameters in the 

Signals area:

– Number of Signals—Displays the number of signals that have 

been selected for export. 

– Signal Label—Displays the name of each signal.

– Units—Displays the engineering unit associated with each 

signal.
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– Filter Type—Indicates whether the signal had a filter applied 

to it, and if so, the type of filter.

– Transform Type—Indicates whether the signal had a 

transform applied to it, and if so, the type of transform.

• Start Data/End Data—Contains the data array for each signal that 

was selected for export. BioBench exports only the data that you 

highlighted in the Analysis view. 

Note: If you select the Append? option in the Export Data dialog box, BioBench 

places the appended data sets after the last data set in the exported file. 

Saving Changes to Your Data Files

You can make changes to your BioBench data files and save these 

changes.

Note: BioBench saves all data in its original form. It does not save the results of 

transforms or filters.

As described earlier in this chapter, you can change some of the 

information associated with your data files (that is, notes, testgroup, 

username, events). Select File»Save to save these changes.

If you try to open another file while the current file has changes which 

can be saved, BioBench prompts you to save your data.

Saving and Recalling BioBench Settings

When you exit BioBench, your BioBench configuration settings are 

saved automatically. You can also store these settings to a file that you 

can use in a future session in BioBench. Multiple users of BioBench can 

keep independent files containing the custom settings they need.

To save your settings to a file, select Configure»Save Settings. Select 

Configure»Recall Settings to open the settings file you want. Select 

Configure»Reset Settings to undo any settings changes you make 

during an entire session in BioBench.

The next chapter, Chapter 6, Printing Data, tells you how to print 

waveform displays and reports from BioBench.
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Chapter

6Printing Data

This chapter explains how BioBench can print snapshots of your signals 

as they appear on the screen, or print reports that summarize the data 

you acquire. 

Printing a Screen

You can print out all signals as they appear on the screen by taking a 

snapshot of the screen. You can print a snapshot in any of the 

acquisition and analysis views, and also in any of the tabs of the Array 

Analysis dialog box. In the acquisition and analysis views, you select 

Print Window from the File menu to print a screen. In the Array 

Analysis dialog box, you click on the Print button to print the dialog 

box. 

Printing Reports on Data Files and Testgroups

To print summary reports, select File»Reports. The Reports dialog box 

appears. Using the Reports dialog box, you can print data file 

information from a specific data directory, for a specific user or all 

users, or for a specific testgroup or all testgroups. 

Note: These reports do not contain the actual signals contained in the data files. 

To print displays of the actual signals, please see the Printing a Screen 

section. 

You can print the following three basic sets of information in a 

BioBench report.

• Testgroups, including the following information, sorted 

alphabetically by testgroup name:

– Testgroup name

– Date and time created

– Notes
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• Data files, including the following information, sorted 

alphabetically by filename:

– Filename

– Date and time created

– Username of the person who acquired the data

– Testgroup (if any) associated with the data file

– Sample rate at which the data was collected

– Labels of the signals acquired

– Notes associated with the data file

• Data files (including the information listed above), sorted by 

testgroup

Figure 6-1 shows the Reports dialog box with Testgroup selected in the 

Report Type area.

Figure 6-1.  Reports Dialog Box with Testgroup Report Type Selected
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The following controls appear in the Report Selection area:

• Data Path—This is the directory that BioBench searches for data 

files to meet the selection criteria.

• Browse—Allows you to select a directory for the Data Path.

• Report Type, Testgroup—Creates a Testgroup report.

• Report Type, Data File Information—Creates a Data File 

Information report.

• Sort by Testgroup—Creates the Data File Information report, 

sorted by testgroup.

Figure 6-2 shows a view of the Reports dialog box in which the Report 

Type is Data File Information and the user has selected the Sort by 

Testgroup option. Notice that the Username Selection area is active for 

this type of report.

Figure 6-2.  Reports Dialog Box with Data File Information Report Type Selected
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You use the following controls in the Reports dialog box to define the 

selection criteria for the report:

• Testgroup Selection—The controls in this area are available for 

both report types.

– All—This option includes all testgroups in the report.

– Selected—This option includes only a single testgroup in the 

report. When you choose this option, the list to the right 

becomes active and you are allowed to select a single 

testgroup. 

• Username Selection—The controls in this area become active when 

you select Data File Information as the Report Type. (You cannot 

sort a Testgroup report by username, so these controls are disabled 

when you select the Testgroup report type.)

– All—This option includes all usernames in the report.

– Selected—This option includes only a single username in the 

report. When you choose this option, the list to the right 

becomes active and you are allowed to select a single 

username. 

Note: A bullet appears beside the testgroup and username lists to indicate the 

current testgroup and username. The bulleted testgroup and username is 

associated with any new data files you create.

You have reached the final section of the BioBench User Manual. 

Remember that Appendix A, Using Help and Troubleshooting, contains 

many useful tips. And Appendix B, Examples, gives you step-by-step 

instructions on using BioBench.
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Appendix

A
Using Help and 
Troubleshooting

This appendix explains how to use the BioBench online help features 

and also offers some troubleshooting tips.

Getting Help
To get help within the BioBench application, you can access the Help 

menu. You can use the following types of help:

• Pop-Up Help—This option opens or closes a small help window. 

With the help window open, place your mouse over any object on 

the front panel to view more information regarding that object. You 

can also press <Ctrl-h> to open or close this window.

• About BioBench—This option provides information about 

National Instruments Corporation, the version of BioBench, and 

the currently installed version of NI-DAQ.

Troubleshooting
This section contains some hints to help you if you encounter trouble 

using BioBench.

BioBench Indicates That NI-DAQ Is Not Installed
When BioBench is loading, a message might appear indicating that 

NI-DAQ is not installed. NI-DAQ is the software that communicates 

with your DAQ hardware. If you will be performing data acquisition, 

you need to install NI-DAQ, install your DAQ hardware, and configure 

your DAQ hardware. Please refer to your NI-DAQ User Manual for PC 

Compatibles for more information on installing NI-DAQ and 

configuring your DAQ hardware.

BioBench Indicates That DAQ Hardware Is Not Installed
DAQ hardware is only necessary when you use BioBench to perform 

data acquisition. BioBench indicates that no National Instruments DAQ 

hardware is installed in the following ways:
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• When you launch BioBench, a dialog box appears explaining that 

you do not have DAQ hardware installed.

• No DAQ devices appear in the Select Data Source dialog box.

• An error message appears when you select Configure»Channels in 

an acquisition view.

Please refer to your DAQ hardware user manual for more information 

on installing your hardware.

Error -10846 When Performing Data Acquisition
This error message appears when you are acquiring signals faster than 

your computer can display them on the screen and also store them to 

disk when data logging is enabled. This situation overloads your 

computer and prevents it from performing all required tasks.

You should ensure that your system meets the Minimum System 

Requirements as described in Chapter 2, Setting Up Your System. Even 

when your system meets the minimum system requirements, you may 

continue to have difficulties in certain situations described below.

• Running other applications while you acquire data can reduce 

performance and memory availability. It is preferable that you 

close other applications while acquiring data in BioBench. Beware 

of hidden or background programs that are running. If you have, for 

instance, anti-virus programs running when you encounter error 

-10846, you can disable them to determine if they are using up 

resources and causing the problem.

• Windows 95 suspends all other computer activities while you drag 

a title bar. Do not click and drag the title bar of a window with the 

mouse during acquisition. 

• There are several features of BioBench which use significant 

resources. If you are using any of these features when you 

encounter the -10846 error, you should consider disabling them. 

The following are some features in BioBench that can be disabled 

to increase performance:

– Alarm Checking—Refer to the Configuring Alarms section in 

Chapter 2, Setting Up Your System for more information on 

alarm checking. Alarms are for display purposes only, and you 

can always define Search Events to search for alarm conditions 

during analysis. Refer to the File and Search Events section in 

Chapter 4, Analyzing Data for more information on search 

events.
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– Acquiring Data from Many Different Signals—BioBench can 

acquire up to 16 signals simultaneously. Each additional signal 

requires additional computer resources. Make sure that you are 

only acquiring data from signals that you really need. Refer to 

Chapter 2, Setting Up Your System, for more information.

– Acquiring Data at a High Sample Rate—Although BioBench 

allows you to sample data at up to 1,000 Hz, many 

physiological signals do not require sample rates of more than 

100 or 200 points per second. Try slowing down your sample 

rate. Refer to Chapter 2, Setting Up Your System, for more 

information.

Acquired Data is Noisy
There are many reasons why your data may appear to be noisy or 

distorted. Some of these reasons are related to hardware configuration 

and some are related to software configuration.

• Cabling—Ensure that all cables are connected correctly and 

securely.

• Improper Ground—Check the ground references of your signal. 

Ensure that the NI-DAQ Configuration Utility shows your 

hardware’s analog input reference mode to be properly configured. 

Refer to the user manual of your DAQ hardware for details about 

analog input reference modes and how to connect your signals.

• Improper Voltage Range—In the Channel Configuration dialog 

box presented in Chapter 2, Setting Up Your System, you specify for 

each signal the minimum and maximum voltages you expect. If 

these values are inaccurate, BioBench may acquire noisy or 

incorrect data.

• Signal Is Too Small—Your signal can be of such a small voltage 

level that noise distorts the signal. Typically, in this case you 

should be using data acquisition hardware which applies a gain to 

amplify your signal and thus reduces this distortion. Not all DAQ 

hardware is capable of applying gain. If you do not have a means to 

apply gain to amplify your signal, you cannot acquire signals that 

have small voltage levels. Refer to the user manual of your 

hardware for instructions on configuration.

• Mixed Signals—You may be simultaneously acquiring high-level 

and low-level signals. Low-level signals (<1 VDC) typically 

require that gain be applied by the DAQ hardware, to reduce noise. 

Some DAQ hardware does not allow you to apply gain to some 
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signals and not to others. In this case, you should use DAQ 

hardware that allows you to apply a different gain to each signal. 

Refer to the user manual of your hardware for instructions on 

configuration.

In addition to addressing the preceding possible cases, you can also try 

the following measures:

• Software Filtering—BioBench allows you to reduce noise in your 

signal caused by 50- or 60-Hz power sources by applying a 50- or 

60-Hz notch filter. See Chapter 3, Acquiring Data, and Chapter 4, 

Analyzing Data, for information about enabling the BioBench 

software filtering.

• Hardware Filtering—It is always best to remove noise from your 

signals before the signals are acquired in BioBench, if possible. 

You can design a hardware filter if you have the expertise to do so.

• Increase Sample Rate—In some cases, the noise you see may be 

caused by undersampling. Undersampling means that you are not 

sampling fast enough to acquire your signals correctly. Sometimes 

increasing the sample rate can improve the signal.

Cannot See the Data in a Graph
Be sure that you have clicked on the GO button in the data 

acquisition view.

Click on the Autoscale button above the graph.
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Appendix

BExamples

This appendix gives you step-by-step examples on how you can use 

BioBench. Some of these examples use data files that come with your 

BioBench application in the \biobench\examples directory. 

Example 1: Getting Started with Acquisition
In this example, you collect physiological data from four different 

signals—ECG, arterial pressure, oximetry, and airway pressure 

(PAW)—at a sample rate of 200 Hz, for an unspecified duration.

1. Connect each signal to an available input channel (ACH0, ACH1, 

ACH2, and ACH3) on your National Instruments terminal 

connector (BNC-2080, BNC-2081, BNC-2090, and so on). See the 

user manual of your DAQ hardware and terminal connector for 

details.

2. Launch BioBench and log in. Figure B-1 shows the User Login 

dialog box.

 

Figure B-1.  User Login Dialog Box
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3. Configure each DAQ channel by performing the following steps:

a. Select Configure»Channels. Figure B-2 shows the Channel 

Configuration dialog box that appears.

Figure B-2.  Channel Configuration Dialog Box

b. Select the National Instruments device you want to use from 

the Data Acquisition Hardware pull-down list. If the correct 

data acquisition hardware does not appear, make sure you have 

properly configured the hardware using the NI-DAQ 

Configuration Utility.

c. Assign a signal to a specific channel on the DAQ hardware by 

selecting a channel number in the Channels list box and typing 

in a name in the Signal Label field. For example, to assign ECG 

Lead 1 to channel 0, highlight channel 0 in the Channels list 

box and enter ECG Lead 1 in the Signal Label field.

d. You can directly enter the signal voltage range, reference the 

range from the vendor database, or determine it by a calibration 
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routine. Enter the minimum and maximum signal voltages in 

the Min and Max fields in the Signal Voltage Range area.

e. Select or create the appropriate unit in the Scaling area for the 

signal you are acquiring. For this example, you select vdc 

for ECG.

f. Enter the minimum and maximum engineering values of the 

signal in the Min (egu) and Max (egu) fields of the Scaling 

area. For alternative methods of scaling physiological signals, 

see Chapter 2, Setting Up Your System.

g. Repeat steps c through f for each of the physiological signals.

h. Highlight each channel that does not have a signal connected 

and click on the Disconnect Signal button.

Tips In this example, you will enter the signal voltage range directly. 

Alternatively, you could click on the Vendor Database button to display the 

Vendor & Device Database Maintenance dialog box. If you have already 

configured the vendor database with the voltage range and calibration 

factors for the device you are using, you can select this device from the 

vendor database to automatically configure any channel. Refer to the 

Entering Vendor Information section in Chapter 2, Setting Up Your System, for 

more information.

4. Click on OK to confirm your channel configuration.

5. Select Configure»Settings, then select the Timing tab in the dialog 

box that appears. Choose a sample rate of 200 Hz from the Sample 

Rate pull-down list. Figure B-3 shows the Timing tab in the 

Configuration Settings for Acquisition dialog box. 
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6. Leave the Start Time and Stop Time settings on Manual. The Scan 

List should contain the names of the signals you configured in the 

Channel Configuration dialog box.

Figure B-3.  Setting Sample Rate, Configuration Settings for Acquisition Dialog Box

7. Click on OK to confirm your settings.

8. Start data acquisition by clicking on the GO button.

9. Enable data logging by clicking on the Log Data checkbox in the 

Logging area in the data acquisition view. BioBench displays the 
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dialog box shown in Figure B-4, prompting you to name the 

data file.

Figure B-4.  File Dialog Box

Alternatively, you can configure BioBench to automatically name 

each file. For example, if the first filename is labeled BioBench, 

the sequential datalog files are named BioBench001, 

BioBench002, and so on. Refer to the Logging Data section in 

Chapter 5, Saving Data, to learn about setting data logging options. 

Figure B-5 shows the 4 Graph Acquisition view with the Log Data 

checkbox activated. 
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Note: You can turn data logging on or off, initiate trending, adjust chart speed, 

and create user events and notes for the data file during acquisition.

Figure B-5.  4 Graph Acquisition View with Data Logging Enabled

10. Stop data acquisition by clicking on the STOP button.

11. If you want to perform analysis on the data you just collected, click 

on the Analysis button to go to the analysis view. Refer to 

Chapter 4, Analyzing Data, for more information on analyzing your 

data.
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Example 2: Pressure-Volume Data Acquisition
To acquire and display two signals (in this example, pressure and 

volume) in real time on an XY graph, complete the following steps. 

This example also shows you how to initiate data acquisition after a 

specified delay.

1. Complete steps 1 through 4 of Example 1: Getting Started with 

Acquisition to assign LV Pressure, LV Volume, and ECG to three 

channels. 

2. Select Configure»Settings, then select the Timing tab in the dialog 

box that appears. Figure B-6 shows how you need to set up the 

Timing tab.

Figure B-6.  Setting Timing in the Configuration Settings for Acquisition Dialog Box

a. Click on the Start Time, After Specified Delay radio button and 

enter text in the Delay Duration field in hh:mm:ss format. For 

example, if you want to initiate data acquisition 2 minutes and 

35 seconds after clicking the GO button, enter 2:35.

b. Select the desired sample rate from the Sample Rate pull-down 

list. In this example, a sample rate of 100 samples per second 

is selected.
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c. Prepare to take a 30-second snapshot of data by clicking on the 

Stop Time, After Specified Duration radio button and 

entering 30.0.

3. Click on OK to confirm your settings.

4. With BioBench you can view real-time data in a variety of formats 

by using the View menu. You can display up to eight graphs of data 

simultaneously. In this example, select View»XY Graph 

Acquisition to view the data as an XY graph. Figure B-7 shows the 

XY Graph Acquisition view.

Figure B-7.  XY Graph Acquisition View

5. Select the # Points to Display on the XY graph by entering the 

number of points you want BioBench to display or by using the 

slide control. In this example, displaying 1,000 points with a 

sample rate of 100 samples per second profiles the last 10 seconds 

of data in the XY Graph.
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6. Use the pull-down lists for the X and Y axes to select the desired 

signal for each axis. In this example, select the pressure signal for 

the Y axis and the volume signal for the X axis.

7. Click on the Log Data check box in the Logging area to log your 

data. See step 9 from Example 1: Getting Started with Acquisition for 

more information about data logging options. 

8. Start data acquisition by clicking on the GO button. The 

Pressure-Volume Loops display in the XY Graph while the 

pressure and volume data displays independently on the two lower 

graphs.

9. Stop data acquisition by clicking on the STOP button.

Example 3: Data Acquisition Using Analog Output
If your DAQ hardware can generate analog output, BioBench allows 

you to acquire and display multiple signals in real time while 

simultaneously producing an analog output signal. The analog output 

signal is based on user-defined parameters. To configure BioBench to 

generate an analog output signal, perform the following steps:

1. Select Configure»Channels to assign each signal to a channel. See 

previous examples in this appendix to learn about setting up 

acquisition channels. 

Note: You can view and record the output stimulus by splitting out the output 

signal and connecting one of the cables to an available input channel 

(ACH0, ACH1, ACH2, and so on) on your National Instruments terminal 

connector (for example, BNC-2080, BNC-2090). Refer to the user manual 

of your DAQ hardware for details.

2. Click on OK to confirm your channel configuration.

3. Select Configure»Settings, then set your parameters for timing, 

alarms, and output stimulus signals in the dialog box that appears. 

Figure B-8 shows how to set up the Stimulus tab of the 

Configuration Settings for Acquisition dialog box. If you choose to 

view the stimulus signal as you acquire your data, be sure to include 

the analog input channel connected to the analog output in the Scan 

List of the Timing tab.
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Figure B-8.  Setting Up Stimulus in the Configuration Settings for Acquisition 

Dialog Box

a. Select the Front Panel Manual Control radio button. This 

option allows you to generate an analog output signal by 

clicking on the stimulus output button (the button labeled 

OUT). 

b. Enter the desired values for Off Voltage and On Voltage.

c. Click on the OK button to confirm your settings.

Note: In addition to manual control, BioBench can generate analog output 

signals in the form of a user-defined pulse or by reading a predefined 

waveform from a file. The selected output signal can be continuous or can 

iterate for a defined number of times. Refer to the Defining an Output 

Stimulus section of Chapter 2, Setting Up Your System, for more information.

BioBench issues the output stimulus on Analog Output channel 0. 

Refer to the user manual for your terminal connector for details. 

Because you configured the stimulus output to be Front Panel 

Manual Control, BioBench generates the predefined analog output 

On Voltage whenever you click and hold on the stimulus output 

button (the button labeled OUT on the Acquisition view). 

BioBench generates the predefined analog output Off Voltage 

whenever you do not click on the stimulus output button. 
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4. Click on the GO button to begin your acquisition and the STOP 

button to end it. During acquisition, try clicking on the OUT button 

to change the analog output voltage of BioBench.

Note: Analog outputs can only be generated when BioBench is acquiring data. 

Example 4: Trending Heart Rate and Replaying a 
Data File

This example demonstrates how you can use the transformation features 

of BioBench to determine heart rate (beats per minute) and heart rate 

variability from a standard ECG signal. By determining the time 

interval between peaks (QRS complexes), BioBench can calculate and 

plot heart rate (and heart rate variability) as a function of time. 

Note: This example does not require external hardware. You “acquire” data from 

a BioBench playback file.

BioBench can trend and display rate information (for example, heart 

rate, respiration rate, or any other periodic signal) during data 

acquisition. In this example, BioBench determines heart rate from an 

ECG signal. In addition, this example illustrates how the Data Source 

option allows you to “acquire” or replay an example data file or any 

other data file previously collected by BioBench.

1. Select Configure»Data Source and click on the radio button 

labeled Demonstration/Teaching Data Sets.

2. Highlight the file A Demo File.bb and click on the OK button.

3. Select View»2 Graph Acquisition from the View menu to display 

both the ECG and the corresponding arterial pressure signal.
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4. Click on the Setup button in the trending area to enable trending 

and configure the beat per minute (BPM) calculation parameters as 

shown in Figure B-9. 

Figure B-9.  BPM Calculation, Trend Setup Dialog Box

5. Click on the signal pull-down list in the trending area to display the 

names of all the signals on the screen. Select the ECG signal. 

6. Select the trend type from the pull-down list in the Trending area in 

the data acquisition view. You can select Min, Max, Mean, or BPM. 

For this example, select the BPM option. 

7. Click on the GO button to begin acquiring data from the example 

file. You will observe that the numeric indicator (above the Trend 

Setup button) displays the heart rate over the last ten seconds. 

Watch this value change over time and then proceed to the next step 

to view this data graphically.

8. Click on the Trend button in the Trending area to see the trend 

graph like the one in Figure B-10. Try viewing the Trend Graph at 

different times as the trend values change over time. For more 

information about trending, refer to Chapter 3, Acquiring Data.

Figure B-10.  Trend Graph of Beat per Minute (BPM) Calculation
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9. Eventually, replay of the data file will end, or you can choose to 

click on the STOP button.

Using Alarms to Display Heart Beats During Data Acquisition 
To use an alarm indicator to display each beat (in other words, each 

QRS complex), perform the following steps:

1. Select Configure»Settings, then select the Alarms tab in the 

Configure Settings for Acquisition dialog box that appears.

2. Enable alarms by selecting the Alarms Enabled? checkbox, as 

shown in Figure B-11.

Figure B-11.  Setting Alarms in the Configuration Settings for Acquisition Dialog Box

3. Highlight the ECG signal as shown in Figure B-11. The ECG 

monitor in this example provides a –5 to 5 VDC analog signal. 

Because the QRS complex for this lead configuration yields a 

positive deflection, BioBench detects a heart beat when the 

waveform exceeds 1.25 VDC. Set the Alarm Type to Above Max. 
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Enter a Max value of 1.25 in the Max text box. Give the alarm a 

label by typing heart beat into the Label text box.

Figure B-12.  2 Graph Acquisition with Heartbeat Indicator (QRS Complex)

4. Click on OK to accept your settings.

5. Click on GO to begin acquiring data from the example file. The 

alarm LED labeled heart beat should flash each time the heart 

beat alarm condition is met.

Look at Figure B-12 for an example of the real-time data acquisition 

view in which the ECG signal (and the heart beat indicator) is in the top 

graph. Remember that you can define many other alarms besides heart 

beat.
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Example 5: Analyzing Heart Rate
In addition to displaying and trending heart rate information during data 

acquisition, BioBench allows you to transform ECG data (or any other 

periodic waveform) into a heart rate (frequency) profile when viewing 

the signal in an analysis view.

To transform ECG data into a heart rate profile, perform the following 

steps:

1. Use the View menu to access one of the Analysis views. For this 

example, choose the 2 Graph Analysis view.

2. Select File»Open in the Analysis mode and use the Browse button 

to navigate to the \biobench\examples directory. Highlight the 

examples directory and click on the Select button, shown in 

Figure B-13.

Figure B-13.  Selecting the Examples Folder with the File Dialog Box

3. Figure B-14 shows the File Open dialog box, which lists all the 

files in the \biobench\examples directory. The example file A 

demo File.bb contains eight signals of physiological data, two of 

which are variable ECG waveforms. Open this example file by 

clicking on the file and then clicking on the OPEN button which 

returns you to the Analysis view and displays the first two signals 

in the file on the two graphs of the Analysis view. The ECG data 
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appears in the upper graph and a blood pressure waveform appears 

in the lower graph.

Figure B-14.  Selecting a Data File in the File Open Dialog Box

4. Click on the signal label in the upper left corner of the bottom 

graph. The Select Signal dialog box shown in Figure B-15 appears. 

Highlight the ECG signal in the List of Signals.

5. Enter Heart Rate Profile in the Signal Label field. Then, in the 

Transform area, select the beats per minute (BPM) option. Be sure 

to apply the following settings for the BPM parameters:

• %Threshold = 80 

• Width = 3 

• Use Derivative, checked

• Mode, Maximums
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These parameters will generate the heart rate profile of the ECG. 

Click on the OK button.

Figure B-15.  Select Signal Dialog Box for BPM Transformation
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6. Inspect Figure B-16 as an example of the graph of the heart rate 

from the ECG data. The top graph shows the raw ECG signal, while 

the bottom graph shows the corresponding heart rate profile. To 

view the entire data file, click on the middle navigation button 

shown to the left of this paragraph.

Figure B-16.  Heart Rate Profile from ECG Data
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Example 6: Analyzing Multiple Files and Signals
This example demonstrates how BioBench can open and analyze 

signals from multiple files, allowing you to simultaneously view and 

analyze signals that were collected at different times. 

In this example you examine variation in the heart rate of a subject at 

rest (baseline) and during subsequent stages of a treadmill test in which 

the subject exercises at increasing intensities. Predictably, the heart rate 

increases over the duration of the graded exercise test as the speed and 

grade of the treadmill increase.

Example Five explained how to open a single data file using the 

File»Open menu. This example tells you how to open multiple data files 

and then select signals from each of the files to display in an Analysis 

view.

1. Use the View menu to select the 4 Graph Analysis view.

2. Assign a signal to be displayed in the top graph by clicking on the 

signal label located in the upper left corner of the top graph. (The 

OFF signal label appears when no data is displayed.) The Select 

Signal dialog box appears, as shown in Figure B-17.

Figure B-17.  Select Signal Dialog Box

3. Click on the Open Files button to open a data file. The File Open 

dialog box appears as shown in Figure B-18. (You may have to use 
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the Browse button to navigate to the \biobench\examples 

directory.) 

Figure B-18.  Selecting a Data File with the File Open Dialog Box

4. Click on the filename ECG #2 (60 BPM). Make sure the Append? 

checkbox is deselected and then click on the OPEN button. You 

must deselect the Append? checkbox so that any other files that are 

opened will be closed. The Select Signal dialog box now displays 

only signals from the ECG #2 (60 BPM) data file. 

5. Choose ECG from the List of Signals. The signal then appears in 

the Signal Label control, where you can enter a more meaningful 

name. Enter Stage 1: HR = 60. Click on OK. The 4 Graph 

Acquisition view returns and now displays the ECG data in the top 

graph.

6. Repeat steps two through five for each of the three remaining 

graphs. However, for every step 4 you must now select the Append? 

checkbox in the File Open dialog box, so that BioBench can open 

multiple data files. The three files you should open are 

ECG #3 (80 BPM), ECG #4 (120 BPM), and 

ECG #5 (180 BPM). 
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As you repeat step 5, the Select Signal dialog box lists the signals 

contained in all the data files you have opened. Notice that 

BioBench temporarily attaches a prefix to the name of each signal:

• The prefix file 1 precedes the names of the signals from the 

first data file you opened.

• The prefix file 2 precedes the names of signals from the 

second data file you opened, and so on.

The prefixes help you easily distinguish signals from multiple files. 

For each of the files you open, select the ECG signal from the list 

of available signals.

When you select the ECG signals, change the names of the signals 

in the Signal Label field to Stage 2: HR = 80, 

Stage 3: HR = 120, and Stage 4: HR = 180, respectively.
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7. After you select a signal for each of the four graphs, click on the 

Autoscale button for each graph. Figure B-19 presents an example 

of the 4 Graph Analysis view showing a subject’s increasing heart 

rate during a graded exercise test.

Note: You must click on the Append? checkbox to have multiple files open at the 

same time.

Note: BioBench allows you to open an unlimited number of files for comparison 

and analysis. However, the number of signals you can view at a time is 

limited by the analysis view you use. For example, the Overlaid Analysis 

view allows up to eight signals.

Figure B-19.  Simultaneous Analysis on Multiple BioBench Data Files
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Example 7: Performing Array Analysis
In addition to displaying and analyzing your data with respect to time, 

BioBench allows you to analyze XY data. The following two examples 

demonstrate array analysis features. The first example illustrates how 

you can profile two pressure relationships in an XY graph. The second 

example demonstrates how you can derive a new signal (volume) by 

integrating a signal (flow) to yield a flow-volume loop.

Profiling Pulmonary Pressure Relationships
In this example, BioBench profiles the relationship of pulmonary 

airway pressure (delivered by a ventilator) and the corresponding 

pressure in the lung.

1. Select View»2 Graph Analysis to display and analyze the two 

signals of interest.

2. Select File»Open and open the example data file called 

Cardiopulmonary Study. (You may need to use the Browse 

button to navigate to the \biobench\examples directory.) This 

file contains the ventilator and lung pressure signals. Figure B-20 

illustrates this step in the File Open dialog box.

Figure B-20.  File Open Dialog Box

3. If the Append? checkbox is active and selected, you should deselect 

it, so that only the file you select will open. Click on the OPEN 

button. The Analysis view returns and the data from the first two 

signals in the file automatically fill the graphs.
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4. Now you need to change the signals displayed in the top and bottom 

graphs. Click on the label of the top graph; the Select Signal dialog 

box appears. Select Lung Pressure and click on OK. Refer to 

Example 5: Analyzing Heart Rate for an explanation of this 

dialog box. 

5. Repeat the previous step for the bottom graph and choose the Paw 

Pressure signal.

6. Now that you have the two signals on your Analysis view, highlight 

a region of data by clicking and dragging your mouse over the 

graphs. Figure B-21 shows the 2 Graph Analysis view with a subset 

of data highlighted. 

Figure B-21.  Data Selection in the 2 Graph Analysis View
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7. Click on the Array button to the right of either graph to display the 

Array Analysis dialog box. Select the XY Analysis tab to display 

the pressure relationship loops as shown in Figure B-22.

Figure B-22.  Array Analysis-Pulmonary Pressure Relationships

Profiling Flow-Volume Loops Using Filters and Transforms
To display flow-volume loops for pulmonary function studies on an XY 

graph, complete the following steps. This example also shows you how 

to filter and transform signals. In this example, you transform a flow 

signal by integrating over time to yield volume.

1. Select View»4 Graph Analysis to view the data.

2. Click on the signal label of the top graph. The Select Signal dialog 

box appears. Click on the Open Files button to open the data file 

Flow-Volume Example in the \biobench\examples directory. 

(You may have to use the Browse button to navigate to the 

\biobench\examples directory.) If the Append? checkbox is 
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active and selected, you should deselect it, so that only the file you 

select will open. 

3. Click on the OPEN button. You return to the Select Signal dialog 

box. Figure B-23 illustrates the Select Signal dialog box for the 

Flow-Volume Example data file.

Figure B-23.  Select Signal Dialog Box (Flow-Volume Example File)

4. Display the Flow, Airway signal in the top graph of the analysis 

view by clicking on the OK button. 

5. You can apply a software filter to smooth the Flow, Airway signal. 

To display this filtered data on the second graph, click on its label. 

Again, the Select Signal dialog box appears. Select the Flow, 

Airway signal and change the Signal Label to Filtered Flow, 

Airway. Choose the Median Filter option from the Filtering 

pull-down list, enter the value 0.050 in the # Seconds field and 

click on the OK button.

6. In this example, the corresponding volume signal (Volume, 

Airway) was available in the form of an analog voltage. To display 

this data in the third graph, click on its label and select Volume, 

Airway from Select Signal dialog box. Click on the OK button.

7. If the volume signal were not available as an analog voltage, 

BioBench could derive it by integrating the flow signal. To display 

the integrated flow (in other words, volume) signal on the bottom 

graph click on its label and select the Flow, Airway signal. Change 

the Signal Label to Integrated Flow (Volume). Choose the 

Median Filter option from the Filtering pull-down list, enter the 



Appendix B Examples

© National Instruments Corporation B-27 BioBench User Manual

value 0.050 in the # seconds field. Choose the Integral option from 

the Transform pull-down list and click on the OK button. 

Figure B-24 shows each of these signals in the 4 Graph 

Analysis view.

Notice that the volume signal from the ventilator (in graph three) 

closely matches the Integrated Flow (in graph four) which BioBench 

derived from the raw flow signal.

Figure B-24.  4 Graph Analysis View of Flow and Volume Waveforms

8. To display the flow and volume signals in an XY Graph, highlight 

a region of data by clicking and dragging your mouse over the 

graphs. Be sure that you highlight at least one complete pulmonary 

cycle, to display a good loop. Click on the Array button to the right 

of any graph to display the Array Analysis dialog box. 

9. Click on the XY Analysis tab and select Filtered Flow, Airway for 

the Y axis and Integrated Flow (Volume) for the X axis. 

Figure B-25 displays the Flow-Volume loop for the highlighted 
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breath. For more information on the XY Analysis tab, refer to the 

XY Analysis section of Chapter 4, Analyzing Data.

Figure B-25.  Flow-Volume Loop
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Appendix

CCustomer Communication

For your convenience, this appendix contains forms to help you gather the information necessary 

to help us solve your technical problems and a form you can use to comment on the product 

documentation. When you contact us, we need the information on the Technical Support Form and 

the configuration form, if your manual contains one, about your system configuration to answer 

your questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to 

quickly provide the information you need. Our electronic services include a bulletin board service, 

an FTP site, a fax-on-demand system, and e-mail support. If you have a hardware or software 

problem, first try the electronic support systems. If the information available on these systems 

does not answer your questions, we offer fax and telephone support through our technical support 

centers, which are staffed by applications engineers. 

Electronic Services

Bulletin Board Support

National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of 

files and documents to answer most common customer questions. From these sites, you can also 

download the latest instrument drivers, updates, and example programs. For recorded instructions 

on how to use the bulletin board and FTP services and for BBS automated information, call 

512 795 6990. You can access these services at:

United States: 512 794 5422

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support

To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use 

your Internet address, such as joesmith@anywhere.com, as your password. The support files 

and documents are located in the /support directories.



Fax-on-Demand Support

Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a 

wide range of technical information. You can access Fax-on-Demand from a touch-tone telephone 

at 512 418 1111.

E-Mail Support (Currently USA Only)

You can submit technical support questions to the applications engineering team through e-mail 

at the Internet address listed below. Remember to include your name, address, and phone number 

so we can contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical 

support number for your country. If there is no National Instruments office in your country, 

contact the source from which you purchased your software to obtain support.

Country Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Brazil 011 288 3336 011 288 8528

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Quebec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 01 48 14 24 24 01 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

Israel 03 6120092 03 6120095

Italy 02 413091 02 41309215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico 5 520 2635 5 520 3282

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain 91 640 0085 91 640 0533

Sweden 08 730 49 70 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 377 1200 02 737 4644

United Kingdom 01635 523545 01635 523154

United States 512 795 8248 512 794 5678



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and 

use the completed copy of this form as a reference for your current configuration. Completing this 

form accurately before contacting National Instruments for technical support helps our 

applications engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, 

include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Fax ( ___ )___________________ Phone ( ___ )________________________________________

Computer brand ________________ Model ________________ Processor___________________

Operating system (include version number) ____________________________________________

Clock speed ______MHz   RAM _____MB  Display adapter ___________________________

Mouse ___yes   ___no     Other adapters installed _______________________________________

Hard disk capacity _____MB Brand _____________________________________________

Instruments used _________________________________________________________________

_______________________________________________________________________________

National Instruments hardware product model __________  Revision ______________________

Configuration ___________________________________________________________________

National Instruments software product ____________________________ Version ____________

Configuration ___________________________________________________________________

The problem is: __________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

List any error messages: ___________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

The following steps reproduce the problem:____________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________



BioBench Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each 

item. Complete a new copy of this form each time you revise your software or hardware 

configuration, and use this form as a reference for your current configuration. Completing this 

form accurately before contacting National Instruments for technical support helps our 

applications engineers answer your questions more efficiently.

National Instruments Products

Interrupt level of hardware _________________________________________________________

DMA channels of hardware ________________________________________________________

Base I/O address of hardware _______________________________________________________

BioBench/NI-DAQ versions _______________________________________________________

Other Products

Computer make and model ________________________________________________________

Microprocessor __________________________________________________________________

Clock frequency or speed __________________________________________________________

Type of video board installed _______________________________________________________

Operating system version __________________________________________________________

Operating system mode ___________________________________________________________

Programming language ___________________________________________________________

Programming language version _____________________________________________________

Other boards in system ____________________________________________________________

Base I/O address of other boards ____________________________________________________

DMA channels of other boards _____________________________________________________

Interrupt level of other boards ______________________________________________________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our 

products. This information helps us provide quality products to meet your needs.

Title: BioBench™ User Manual

Edition Date: October 1997

Part Number: 321612A-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Phone ( ___ )__________________________  Fax ( ___ ) ________________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway (512) 794-5678

Austin, TX  78730-5039
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Glossary

B

base name The name of the file before BioBench adds a sequence number. The 

base name is used when you turn on the Autonaming feature.

base path The directory where BioBench creates a log file, whether Autonaming 

is on or off.

bins Equally sized partitions that BioBench creates by subdividing an entire 

range of values for display in a histogram.

C

channel A pathway between your data acquisition hardware and your computer. 

Channels are labeled ACH0, ACH1, and so on, on your terminal 

connectors (such as the BNC-2090 and BNC-2091).

D

data source The source that BioBench acquires data from. Possible sources are 

DAQ hardware, BioBench data files, and example files.

DAQ Data acquisition.

DAQ hardware The equipment that takes the data from your physiological monitoring 

devices and transfers the data into your computer.

DC Direct current.

decimation Process of reducing a large set of data values to a smaller, more 

manageable size. BioBench uses this technique when the user requests 

to see more data than could reasonably fit on a single screen.
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decimation factor Degree to which BioBench uses decimation to reduce a dataset. For 

example, BioBench decimates 30,000 data points to 10,000 data points, 

using a three-to-one decimation factor.

device The instrument that measures and collects your data.

E

EGU Engineering Unit.

event See file events and search events.

event markers A set of color coded lines that appear in the Event Profiler to graphically 

profile, over time, file or search events.

Event Profiler Horizontal bar with vertical markings (event markers) that indicate the 

times at which events occurred during an acquisition. You can view 

these event markers in the Analysis views.

F

FFT Fast Fourier Transform.

file events Times during data acquisition that specific actions took place. 

BioBench handles file events of three types: user-defined events, 

stimulus events, or datalog events. (The File and Search Events section 

in Chapter 4, Analyzing Data, describes events.)

G

gain Amplification of a signal. Data acquisition hardware can increase the 

resolution of a signal by applying amplification to the signal before the 

analog to digital converter converts the signal into a digital 

representation. Increased signal resolution enables BioBench to more 

easily distinguish noise from the actual signal when noise reduction 

techniques such as filtering are used.   

H

Hz Hertz (samples per second).



Glossary

© National Instruments Corporation G-3 BioBench User Manual

L

Label Name you assign to each signal.

LED Light-emitting diode. BioBench uses a virtual LED in its user interface 

to indicate an alarm.

Legend Indicator box showing the display parameters of a signal on a graph 

(that is, signal color, signal style, point style, point color, and so on).

Logging Recording data to disk.

M

mmHg Millimeters of mercury.

N

NI-DAQ National Instruments data acquisition driver software. BioBench needs 

this software to communicate with your DAQ hardware.

notch filter Digital filter used to attenuate a certain frequency or range of 

frequencies in a signal. BioBench uses notch filters to attenuate 50 and 

60 Hz noise caused by power signals.

S

scalar A single, numeric value.

scrollbar Vertical or horizontal bar on the analysis views that allow the user to 

shift the data up, down, left, or right. By clicking on the scrollbar with 

the mouse and dragging, the user activates it. Each scrollbar has dark 

markings on the ends that can be moved to expand or shrink the data set.

search events Times in a data file when special conditions occurred. You can set up 

search criteria to define the special conditions you are looking for in a 

signal. (The File and Search Events section in Chapter 4, Analyzing 

Data, describes events.)
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T

Testgroup Collection of data files.

U

undersampling Failure to sample a signal at an adequate rate. At a minimum, you 

should sample a signal at least twice as fast as the highest frequency 

component of the signal you are acquiring.

user event A file event that a user defines, usually during data acquisition, to 

record comments for a specific time. See file event.

V

vdc Volts, direct current.
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Numbers
2 Graph Analysis view, 4-4, B-24

4 Graph Analysis view, 4-4, B-27

A
Absolute and Relative Time indicators, 4-9

decimation factor, 4-9

dx, 4-9

Initial/final Time, 4-9

window, 4-9

x1, x2, 4-9

acquiring data. See data acquisition.

Acquisition button, 4-9

Add User Event dialog box, 3-6, 4-24

Adobe Acrobat Reader 3.0, 2-2, 2-3

Alarm Options Display dialog box, 3-13

alarms

disabling alarm checking, A-2

example for displaying heart beats, 

B-13 to B-14

viewing alarm information, 3-13

Alarms Tab, 2-14 to 2-16

Alarm Setup Parameters

Alarm Type, 2-16

Label, 2-15

Min, Max, 2-16

Alarms Enabled? checkbox, 2-15

illustration, 2-15

Signals list, 2-15

analog output data acquisition example, 

B-9 to B-11

Analysis button, 3-10, 4-1

analysis views, 4-3 to 4-9

4 Graph Analysis view (figure), 4-4

appearance of graphs, changing, 4-8

changing time scale and scrolling through 

data, 4-7

indicators of the analysis view, 4-8 to 4-9

Absolute and Relative Time 

indicators, 4-9

File indicator, 4-9

Filter/Transform indicators, 4-8

Graph indicator bar, 4-8

overlaid analysis view (figure), 4-5

returning to acquisition view, 4-9

scroll bars for changing scales, 4-7

selecting data and navigating through 

data, 4-6

X axis, changing manually, 4-7

Y scales, changing, 4-7

analyzing data. See data analysis.

array analysis, 4-12 to 4-19

example, B-23 to B-28

histogram, 4-13

peak detection, 4-16 to 4-17

power spectrum, 4-14 to 4-16

XY analysis, 4-18 to 4-19

Array button, 4-12

Autoscaling button

changing Y scale, 4-7

setting scale for graphs, 3-10

x and y, Power Spectrum tab, 4-15

Index
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B
Beat Per Minute (BPM) Calculations 

controls, 3-8

% Threshold, 3-8

Mode (Minimums/Maximums), 3-8

Use Derivative?, 3-8

Width, 3-8

Beats Per Minute (BPM) transform 

option, 4-11

BioBench

features, 1-1 to 1-2

starting, 2-4 to 2-6

system requirements, 2-1

bulletin board support, C-1

C
Calibration dialog box. See Two-Point 

Calibration dialog box.

channel, selecting for graph, 3-11

Channel Configuration dialog box

Channels control, 2-9

Data Acquisition Hardware control, 

2-8 to 2-9

Disconnect Signal control, 2-10

Help button, 2-10

illustration, 2-8

obtaining parameters from Vendor & 

Device Database Maintenance dialog 

box, 2-22

Scaling controls, 2-9 to 2-10

Signal Label control, 2-9

Signal Voltage Range control, 2-9

Vendor Database control, 2-10

Vendor/Device control, 2-10

configuration and set-up, 2-1 to 2-27. 

See also data acquisition configuration.

installing hardware, 2-2 to 2-3

installing NI-DAQ software, 2-1

saving and recalling BioBench 

settings, 5-7

starting BioBench, 2-4 to 2-6

Configuration Settings for Acquisition 

dialog box

Alarm tab, 2-14 to 2-16

illustration, 2-13

Stimulus tab, 2-16 to 2-20

Timing tab, 2-13 to 2-14

Cursor Navigation controls, XY Analysis tab

Arrow controls, 4-19

X value, 4-19

Y value, 4-19

customer communication, xiii, C-1 to C-2

D
DAQ hardware

Channel Configuration dialog box 

(figure), 2-8

configuring channels, 2-8 to 2-10

error message and troubleshooting, 

A-1 to A-2

selecting as data source, 2-7

data acquisition, 3-1 to 3-15

changing data for graphs, 3-11

changing display parameters, 3-11

controlling graph speed, 3-4

digital display, 3-11

Error - 10846 when performing data 

acquisition, A-2 to A-3

examples

getting started, B-1 to B-6

pressure-volume data acquisition, 

B-7 to B-9

using analog output, B-9 to B-11

filtering data, 3-11 to 3-13

logging data, 3-5 to 3-6

pausing the display, 3-3

producing manual stimulus, 3-4

setting scale for graphs, 3-10

starting, 3-3

status display, 3-9



Index

© National Instruments Corporation I-3 BioBench User Manual

stopping, 3-3

switching to analysis mode, 3-10

trending, 3-7 to 3-9

viewing alarm information, 3-13

XY Graph view, 3-14 to 3-15

data acquisition configuration, 2-6 to 2-22

alarms, 2-14 to 2-16

DAQ hardware channels, 2-8 to 2-10

data acquisition view (figure), 2-5

data source selection, 2-6 to 2-7

default settings, 2-6

defining output stimulus, 2-16 to 2-20

testgroup setup, 2-22 to 2-27

timing, 2-13 to 2-14

two-point calibration routine, 2-11 to 2-12

vendor information database, 2-21 to 2-22

data acquisition views, 3-1 to 3-2

data analysis, 4-1 to 4-25

analysis views, 4-3 to 4-9

4 Graph Analysis view (figure), 4-4

appearance of graphs, changing, 4-8

changing time scale and scrolling 

through data, 4-7

indicators of analysis view, 4-8 to 4-9

overlaid analysis view (figure), 4-5

returning to acquisition view, 4-9

selecting data and navigating through 

data, 4-6

Y scales, changing, 4-7

array analysis, 4-12 to 4-19

histogram, 4-13

peak detection, 4-16 to 4-17

power spectrum, 4-14 to 4-16

XY analysis, 4-18 to 4-19

examples

analyzing heart rate, B-15 to B-18

analyzing multiple files and signals, 

B-19 to B-22

performing array analysis, 

B-23 to B-28

file and search events, 4-20 to 4-24

adding new events, 4-23 to 4-24

viewing events, 4-20 to 4-21

viewing or changing, 4-21 to 4-23

File Open dialog box, 4-1 to 4-2

filtering, 4-10

preparation for, 4-1 to 4-3

scalar analysis, 4-11 to 4-12

selecting signal for graph, 4-2 to 4-3

transforming, 4-10 to 4-11

viewing and changing data file 

information, 4-24 to 4-25

Data File Events dialog box, 2-26 to 2-27

Data File control, 2-26

Event Notes control, 2-27

illustration, 2-26

List of Events control, 2-26

Testgroup control, 2-26

Time control, 2-27

data file growth, approximating, 2-14

data file size, approximating, 2-14

Data File Summary dialog box, 2-24 to 2-25

Data Files control, 2-24

Events button, 2-25

General Info control, 2-25

illustration, 2-24

Modify button, 2-24

data logging. See logging data.

Data Logging Setup dialog box, 5-2 to 5-3

Autonaming, no prompt, 5-2

Base Name, 5-2

Base Path, 5-2

Browse, 5-3

illustration, 5-2

Prompt each time, 5-2

data selection and navigation tools, 4-6

data source selection, 2-6 to 2-7

data files acquired with BioBench 

option, 2-7

demonstration/teaching data files 

option, 2-7
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National Instruments data acquisition 

hardware option, 2-7

reasons for changing, 2-6

Select Data Source dialog box 

(figure), 2-7

datalog events, 4-20, 4-21

Delta Y, Scalar analysis option, 4-12

Derivative transform option, 4-11

digital display of data acquisition, 3-11

Disconnect Signal control, Channel 

Configuration dialog box, 2-10

disk space free, approximating, 2-14

display parameters, changing, 3-11

documentation

conventions used in manual, xii

organization of manual, xi-xii

E
electronic support services, C-1 to C-2

e-mail support, C-2

Event button, 4-21

Event+ button, 4-23

Event List & Search Criteria dialog box, 

4-21 to 4-23

Arrow control, 4-22

Delete control, 4-22

Event List control, 4-22

Event Notes control, 4-22

Event Profiler control, 4-22

illustration, 4-21

Open Files control, 4-22

Search Criteria tab (figure), 4-23

Event Profiler, 4-20 to 4-21

Datalog Events, 4-21

File Event/Search Event Selector, 4-21

illustration, 4-20

Search Criteria Met, 4-21

Search Criteria Not Met, 4-21

Stimulus Events, 4-20

User-Defined Events, 4-20

events. See file and search events.

examples, B-1 to B-28

analog output data acquisition example, 

B-9 to B-11

analyzing heart rate, B-15 to B-18

analyzing multiple files and signals, 

B-19 to B-22

data acquisition using analog output, 

B-9 to B-11

getting started with data acquisition, 

B-1 to B-6

performing array analysis, B-23 to B-28

pressure-volume data acquisition, 

B-7 to B-9

trending heart rate and replaying data file, 

B-11 to B-14

Export Data dialog box, 5-3 to 5-4

Append? option, 5-4

Browse button, 5-4

Cancel button, 5-4

Export button, 5-4

Export File Path indicator, 5-4

Export Header Notes field, 5-4

exporting all data, 5-4

illustration, 5-3

Include Events? option, 5-4

Signals control, 5-4

exporting data, 5-3 to 5-7

decimated data (note), 5-4

format of exported BioBench data

BioBench version section, 5-6

Data File Info section, 5-6

sample data file exported

to spreadsheet (figure), 5-5

Signals section, 5-6 to 5-7

Start Data/End Data section, 5-7
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F
fax and telephone support, C-2

Fax-on-Demand support, C-2

file and search events, 4-20 to 4-24

Add User Event dialog box, 4-24

adding new events, 4-23 to 4-24

Event List & Search Criteria dialog box, 

4-21 to 4-23

Event Profiler, 4-20 to 4-21

types of events, 4-20

viewing, 4-20 to 4-21

viewing or changing, 4-21 to 4-23

File dialog box, 5-3

File indicator, for analysis views, 4-9

File Open dialog box, 4-1 to 4-2

Append? checkbox, 4-2

Browse button, 4-2

General Info control, 4-1 to 4-2

illustration, 4-1

Filter radio button, 3-11

filtering data, 3-11 to 3-13

50-60 Hz Notch Filter option, 4-10

choosing filter type, 4-10

Digital Filter option, 4-10

Median Filter option, 4-10

No Filter option, 4-10

notch filter specifications, 3-12 to 3-13

solving noise problems, A-4

Filter/Transform indicators, 4-8

FTP support, C-1

G
GO button, 3-3

Graph Acquisition view (figure), 3-2

Graph indicator bar, 4-8

Engineering Unit, 4-8

Signal Label, 4-8

y1, y2, 4-8

Graph Speed pull-down list, 3-4

Graph Tool Palette, 4-15 to 4-16

Mode button, 4-16

Panning tool, 4-16

Peak Detection tab, 4-17

Power Spectrum tab, 4-15 to 4-16

x and y Autoscaling buttons, 4-15

x.xx and y.yy Scale Format buttons, 4-15

XY Analysis tab, 4-19

Zoom tool, 4-15

graphs. See also analysis views.

changing appearance using legend, 3-11, 

4-8

changing data for, 3-11

changing display parameters, 3-11

digital display, 3-11

setting scale, 3-10

signal selection, 4-2 to 4-3

troubleshooting, A-4

viewing trend graph, 3-9

XY Graph view, 3-14 to 3-15

H
hardware installation, 2-2 to 2-3

BioBench CD, 2-2

creating and using installation 

diskettes, 2-3

heart rate analysis example, B-15 to B-18

heart rate trending example, B-11 to B-14

Help button

2-Point Calibration dialog box, 2-12

Channel Configuration dialog box, 2-10

Help menu

About BioBench, A-1

Pop-Up Help, A-1

high temperature alarm, 3-13

Histogram tab, 4-13

illustration, 4-13

Print button, 4-13

Recalculate button, 4-13

History control, Trend Setup dialog box, 3-8
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I
IIR filter order, 3-12

Info button, 4-24

installation

hardware, 2-2 to 2-3

BioBench CD, 2-2

creating and using installation 

diskettes, 2-3

NI-DAQ software, 2-1

Integral option

Scalar analysis, 4-12

Transforms, 4-11

J
Journal dialog box, 3-5 to 3-6

Event Notes control, 3-5 to 3-6

File Notes control, 3-5

List of Events control, 3-5

Type control, 3-6

L
Legend control

changing graph display parameters, 

3-11, 4-8

Power Spectrum tab, 4-15

XY Analysis tab, 4-19

Linear Conversion control, 2-Point Calibration 

dialog box, 2-12

Gain (m), Offset (b) indicator, 2-12

Graph indicator, 2-12

Logging area of data acquisition views, 

3-5 to 3-6

file display, 3-5

Journal button, 3-5

Journal dialog box, 3-5 to 3-6

Log Data checkbox, 3-5

User Event button, 3-6

logging data, 5-1 to 5-3

configuring, 5-2 to 5-3

Data Logging Setup dialog box, 5-2 to 5-3

enabling logging, 5-1

example, B-5 to B-6

file dialog box, 5-3

M
Maximum option

Scalar analysis, 4-11

Transforms, 4-11

Mean option

Scalar analysis, 4-11

Transforms, 4-11

Minimum option

Scalar analysis, 4-12

Transforms, 4-10

Modify Data File Information dialog box, 

2-25 to 2-26

Existing Testgroups list, 2-25

Existing Usernames list, 2-25

File Notes control, 2-26

illustration, 2-25

OK button, 2-26

multiple files and signals, analysis example, 

B-19 to B-22

N
National Instruments data acquisition 

hardware. See DAQ hardware.

NI-DAQ software

error message, A-1

installing, 2-1

noise attenuation. See notch filter 

specifications.

noise problems, troubleshooting, A-3 to A-4

Notch Filter Frequency control, 2-14
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notch filter specifications, 3-12 to 3-13

50 Hz specifications (table), 3-12

50/60 Hz attenuation, 3-13

60 Hz specifications (table), 3-12

IIR filter order, 3-12

notch width (-3 dB), 3-13

sample rate, 3-12

O
Open File Information dialog box

General Info control, 4-25

illustration, 4-25

Modify control, 4-25

Open Files control, 4-25

OUT button

enabling, 3-4

setting Off voltage, 2-17

output stimulus. See Stimulus tab.

overlaid analysis view (figure), 4-5

P
Peak Detection tab, 4-16 to 4-17

dx control, 4-17

dy control, 4-17

#Found control, 4-17

Graph Tool Palette, 4-17

illustration, 4-16

Mode control, 4-17

Peak/Valley List, 4-17

Print button, 4-17

Width control, 4-17

Power Spectrum tab, 4-14 to 4-16

Display Unit control, 4-15

Est. Frequency Peak control, 4-15

Est. Power Peak control, 4-15

Frame Size control, 4-15

Graph tool palette, 4-15 to 4-16

Mode button, 4-16

Panning tool, 4-16

x and y Autoscaling buttons, 4-15

x.xx and y.yy Scale Format 

buttons, 4-15

Zoom tool, 4-15

Legend control, 4-15

Log/Linear control, 4-15

Print button, 4-15

Recalculate button, 4-14, 4-15

Resolution control, 4-15

Sample Rate control, 4-15

Window control, 4-15

pressure-volume data acquisition example, 

B-7 to B-9

Print button

Histogram tab, 4-13

Peak Detection tab, 4-17

Power Spectrum tab, 4-15

XY Analysis tab, 4-19

printing data, 6-1 to 6-4

reports on data files and testgroups, 

6-1 to 6-4

Reports dialog box with data file 

information report type selected, 

6-3 to 6-4

Reports dialog box with testgroup 

report type selected, 6-2 to 6-3

types of reports, 6-1 to 6-2

screens, 6-1

problem solving. See troubleshooting.

pulmonary pressure array analysis example, 

B-23 to B-28

R
Recalculate button

Histogram tab, 4-13

Power Spectrum tab, 4-14

Regression Analysis control, 4-19

Exponential, 4-19

Linear, 4-19

Polynomial, 4-19
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Relative Time indicators. See Absolute and 

Relative Time indicators.

Reports dialog box

Browse control, 6-3

data file information report type selected, 

6-3 to 6-4

Data Path control, 6-3

Report Type, Testgroup control, 6-3

Sort by Testgroup control, 6-3

testgroup report type selected, 6-2 to 6-3

Testgroup Selection control, 6-4

Username Selection control, 6-4

reports on data files and testgroups, printing, 

6-1 to 6-4

S
sample rate

high rate, system overload due to, A-3

increasing, for solving noise 

problems, A-4

selecting, 2-14

saving data, 5-1 to 5-7

exporting data, 5-3 to 5-7

logging data, 5-1 to 5-3

saving and recalling BioBench 

settings, 5-7

saving changes to data files, 5-7

Scalar analysis options, 4-11 to 4-12

Delta Y, 4-12

Integral, 4-12

Mean, 4-12

Minimum, 4-12

No analysis, 4-12

Slope, 4-12

Standard Deviation, 4-12

scale for graphs, setting, 3-10

automatically, 3-10

manually, 3-10

Screen Update Rate control, Trend Setup 

dialog box, 3-8

screens, printing, 6-1

Search Criteria tab

Displayed Signals control, 4-23

illustration, 4-23

Mix/Max: radio button, 4-23

Search for: radio button, 4-23

search events. See file and search events.

Select Signal dialog box, 4-2 to 4-3

Filename control, 4-3

Filtering control, 4-3

illustration, 4-2

List of Signals control, 4-3

Open Files button, 4-3

Signal Label control, 4-3

Transform control, 4-3

Set Acquisition Scale dialog box, 3-10

# Decimals control, 3-10

Ymax/Ymin controls, 3-10

setting up BioBench. See configuration and 

set-up; data acquisition configuration.

Signal Label control

2-Point Calibration dialog box, 2-11

Channel Configuration dialog box, 2-9

Graph indicator bar, 4-8

Select Signal dialog box, 4-3

Signal selectors, XY Analysis tab, 4-19

Signal Voltage Range control, 2-9

Calibrate parameter, 2-10

Gain & Offset parameter, 2-9

Gain (m), Offset (b) parameters, 2-10

Min & Max parameter, 2-9

Min (egu), Max (egu) parameters, 2-10

Units parameter, 2-9

signals

multiple files and signals, analysis 

example, B-19 to B-22

overloading your computer system, A-3

selecting for graph, 4-2 to 4-3

Signals control, Export Data dialog box, 5-4

Simple Expressions transform option, 4-11

Slope option, Scalar analysis, 4-12
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Standard Deviation option

Scalar analysis, 4-12

Transforms, 4-11

starting BioBench, 2-4 to 2-6

starting data acquisition, 3-3

status display, 3-9

stimulus events, 4-20

Stimulus Tab, 2-16 to 2-20

# Repetitions, Continuous button, 2-19

# Repetitions, Number button, 2-19

analog output data acquisition example, 

B-9 to B-11

configuring stimulus pulse (figure), 2-18

illustration, 2-16

point to remember, 2-20

producing manual stimulus, 3-4

pulse limitations (note), 2-20

row and column limitations (note), 2-19

Stimulus Method, Front Panel Manual 

control, 2-17

Off Voltage, 2-17

OUT button, 2-17

On Voltage, 2-17

Stimulus Method, None control, 2-17

Stimulus Method, User-Define Waveform 

control, 2-17 to 2-19

Stimulus Type, From File control, 

2-18 to 2-19

Stimulus Type, Pulse control, 2-17 to 2-18

Off Time, 2-18

Off Voltage, 2-17

On Time, 2-18

On Voltage, 2-17

STOP button, 3-3

stopping data acquisition, 3-3

subsetting data, 4-6

system requirements, 2-1

T
technical support, C-1 to C-2

telephone and fax support, C-2

Testgroup Setup dialog box, 2-22 to 2-27

accessing, 2-23

Data File Events dialog box, 2-26 to 2-27

Data File Summary dialog box, 

2-24 to 2-25

Date, Time indicator, 2-23

Delete control, 2-23

illustration, 2-23

Modify Data File Information dialog box, 

2-25 to 2-26

modifying data file information, 

2-25 to 2-26

New control, 2-23

New Testgroup dialog box, 2-23

OK button, 2-24

reviewing data file events, 2-26 to 2-27

reviewing data file summary information, 

2-24 to 2-25

setting up testgroups, 2-23 to 2-24

Show Data Files button, 2-24

Testgroup Notes text box, 2-24

Testgroups control, 2-23

testgroups

defined, 2-22

printing. See Reports dialog box.

time scale for analysis views, changing, 4-7

Timing tab, 2-13 to 2-14

Approximate Data File Size/Apprxoimate 

File Growth Rate indicators, 2-14

Approximate Free Disk Space control, 

2-14

Notch Filter Frequency control, 2-14

pressure-volume data acquisition 

example, B-7 to B-9

Sample Rate control, 2-14

Scan List control, 2-14

Start Time, After Specified Delay 

control, 2-13
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Start Time, Manual control, 2-13

Start Time, On Trigger control, 2-13

Stop Time, After Specified Duration 

control, 2-14

Stop Time, Manual control, 2-14

Transform options, 4-10 to 4-11

Beats Per Minute (BPM), 4-11

Derivative, 4-11

Integral, 4-11

Maximum, 4-11

Mean, 4-11

Minimum, 4-10

No transform, 4-10

Simple Expressions, 4-11

Standard Deviation, 4-11

Trend Setup dialog box, 3-7 to 3-8

Beat Per Minute (BPM) Calculations 

controls, 3-8

% Threshold, 3-8

Mode (Minimums/Maximums), 3-8

Use Derivative?, 3-8

Width, 3-8

History control, 3-8

illustration, 3-7

Screen Update Rate control, 3-8

trending, 3-7 to 3-9

enabling, 3-7

entering trend parameters, 3-7 to 3-8

example, B-11 to B-14

setting up, 3-7

viewing trend graphs, 3-8

triggers, for setting start time, 2-13

troubleshooting, A-1 to A-4

acquired data is noisy, A-3 to A-4

cannot see data in graph, A-4

DAQ hardware is not installed, A-1 to A-2

Error - 10846 when performing data 

acquisition, A-2 to A-3

NI-DAQ is not installed, A-1

Two-Point Calibration dialog box

Help button, 2-12

illustration, 2-11

Linear Conversion control, 2-12

Minimum/Maximum Areas control, 

2-11 to 2-12

Accept button, 2-11

Eng. Value field, 2-12

Minimum/Maximum Calibration 

Voltage indicator, 2-12

Voltage meter, 2-11

OK button, 2-12

selecting with Calibrate button, 2-10

Signal Label control, 2-11

Voltage Range control, 2-12

U
User Event button, 3-6

User Login dialog box, 2-4

user-defined events, 4-20

V
Vendor & Device Database Maintenance 

dialog box

illustration, 2-21

modifying, 2-22

opening, 2-10, 2-21

passing parameters to Channel 

Configuration dialog box, 2-22

predefined database, 2-21

Vendor/Device control, Channel 

Configuration dialog box, 2-10

View menu, 3-1

Voltage Range control, 2-Point Calibration 

dialog box, 2-12
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X
X axis, changing manually, 4-7

XY Analysis tab, 4-18 to 4-19

Cursor Navigation controls

Arrow controls, 4-19

X value, 4-19

Y value, 4-19

Graph Tool Palette, 4-19

illustration, 4-18

Legend control, 4-19

Print button, 4-19

Regression Analysis control, 4-19

Exponential, 4-19

Linear, 4-19

Polynomial, 4-19

Signal selectors, 4-19

XY Graph view

description, 3-14 to 3-15

pressure-volume data acquisition 

example, B-7 to B-9

pulmonary pressure examples, 

B-25, B-28

Y
Y axis, changing manually, 4-7
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